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Introducing Microsoft Excel 2010
For those of you who are upgrading to Microsoft Excel 2010 from an earlier version  
of the program, this introduction summarizes the new features in Excel 2010. One of 
the first things you’ll notice about Excel 2010 is that the program incorporates the 
ribbon, which was introduced in Excel 2007. If you used Excel 2003 or an earlier ver-
sion of Excel, you’ll need to spend only a little bit of time working with the new user 
interface to bring yourself back up to your usual proficiency.

Managing Excel Files and Settings  
in the Backstage View

If you used Excel 2007, you’ll immediately notice one significant change: the Microsoft 
Office button, located at the top left corner of the program window in Excel 2007, has 
been replaced by the File tab. After releasing the 2007 Microsoft Office System, the Office 
User Experience team re-examined the programs’ user interfaces to determine how they 
could be improved. During this process, they discovered that it was possible to divide user 
tasks into two categories: “in” tasks, such as formatting and formula creation, which affect 
the contents of the workbook directly, and “out” tasks, such as saving and printing, which 
could be considered workbook management tasks.

When the User Experience and Excel teams focused on the Excel 2007 user interface, they 
discovered that several workbook management tasks were sprinkled among the ribbon 
tabs that contained content-related tasks. The Excel team moved all of the workbook 
management tasks to the File tab, which users can click to display these commands in 
the new Backstage view.
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Previewing Data by Using Paste Preview
One of the most common tasks undertaken by Excel users involves cutting or copying 
a worksheet’s contents, such as text or numbers, and pasting that data into either the 
same workbook or a separate Office document. Users have always been able to paste 
data from the Microsoft Office Clipboard and control which formatting elements were 
pasted into the destination; however, in versions prior to Excel 2010, you had to select 
a paste option, observe the results, and (often) undo the paste and try another option 
until you found the option that produced the desired result.
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In Excel 2010, you can take advantage of the new Paste Preview capability to see how 
your data will appear in the worksheet before you commit to the paste. By pointing to 
any of the icons in the Paste Options palette, you can switch between options to discover 
the one that makes your pasted data appear the way you want it to.

Troubleshooting  The appearance of buttons and groups on the ribbon changes depending 
on the width of the program window. For information about changing the appearance of 
the ribbon to match our screen images, see “Modifying the Display of the Ribbon” at the 
beginning of this book.

Customizing the Excel 2010 User Interface
When the Office User Experience team designed the ribbon interface for Excel 2007, they 
allowed users to modify the program window by adding and removing commands on the 
Quick Access Toolbar. In Excel 2010, you can still modify the Quick Access Toolbar, but you 
also have many more options for changing the ribbon interface. You can hide or display 
built-in ribbon tabs, change the order of built-in ribbon tabs, add custom groups to a 
ribbon tab, and create custom ribbon tabs which, in turn, can contain custom groups. 
These custom groups provide easy access to existing ribbon commands as well as  
custom commands that run macros stored in the workbook.
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Summarizing Data by Using More Accurate 
Functions

In earlier versions of Excel, the program contained statistical, scientific, engineering, 
and financial functions that would return inaccurate results in some relatively rare  
circumstances. For Excel 2010, the Excel programming team identified the functions 
that returned inaccurate results and collaborated with academic and industry analysts 
to improve the functions’ accuracy.

The Excel team also changed the naming conventions used to identify the program’s 
functions. This change is most noticeable with regard to the program’s statistical func-
tions. The table below lists the statistical distribution functions that have been improved 
in Excel 2010.

Distribution Functions
Beta BETA.DIST, BETA.INV
Binomial BINOM.DIST, BINOM.INV

Chi squared CHISQ.DIST, CHISQ.DIST.RT, CHISQ.INV, CHISQ.INV.RT

Exponential EXPON.DIST

F F.DIST, F.DIST.RT, F.INV, F.INV.RT
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Distribution Functions
Gamma GAMMA.DIST, GAMMA.INV

Hypergeometric HYPGEOM.DIST

Lognormal LOGNORM.DIST, LOGNORM.INV

Negative Binomial NEGBINOM.DIST

Normal NORM.DIST, NORM.INV

Standard Normal NORM.S.DIST, NORMS.INV

Poisson POISSON.DIST

Student’s t T.DIST, T.DIST.RT, T.DIST.2T, T.INV, T.INV.2T

Weibull WEIBULL.DIST

Excel 2010 also contains more accurate statistical summary and test functions. The following 
table lists those functions, as well as the new naming convention that distinguishes between 
new and old functions. The Excel programming team chose to retain the older functions to 
ensure that workbooks created in Excel 2010 would be compatible with workbooks created 
in previous versions of the program.

Function name Description
CEILING.PRECISE Consistent with mathematical definition; rounds up towards positive 

infinity regardless of sign of number being rounded
FLOOR.PRECISE Consistent with mathematical definition; rounds down towards 

negative infinity regardless of sign of number being rounded
CONFIDENCE.NORM Name for existing CONFIDENCE function that is internally consistent 

with naming of other confidence function
CONFIDENCE.T Consistent definition with industry best practice;. confidence function 

assuming a Student’s t distribution
COVARIANCE.P Name for existing COVAR function that is internally consistent with 

naming of other covariance function
COVARIANCE.S Internally consistent name with other functions that act on a 

population or a sample
MODE.MULT Consistent with user expectations; returns multiple modes for a range

MODE.SNGL Name for existing MODE function that is internally consistent with 
naming of other mode function

PERCENTILE.EXC Consistent with industry best practices, assuming percentile is a 
value between 0 and 1, exclusive

PERCENTILE.INC Name for existing PERCENTILE function that is internally consistent 
with naming of other percentile function
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Function name Description
PERCENTRANK.EXC Consistent with industry best practices; assuming percentile is a 

value between 0 and 1, exclusive
PERCENTRANK.INC Name for existing PERCENTRANK function that is internally consistent 

with naming of other PERCENTRANK function
QUARTILE.EXC Consistent with industry best practices, assuming percentile is a 

value between 0 and 1, exclusive
QUARTILE.INC Name for existing QUARTILE function that is internally consistent 

with naming of other quartile function
RANK.AVG Consistent with industry best practices, returning the average rank 

when there is a tie
RANK.EQ Name for existing RANK function that is internally consistent with 

naming of other rank function
STDEV.P Name for existing STDEVP function that is internally consistent with 

naming of other standard deviation function
STDEV.S Name for existing STDEV function that is internally consistent with 

naming of other standard deviation function
VAR.P Name for existing VARP function that is internally consistent with 

naming of other variance function
VAR.S Name for existing VAR function that is internally consistent with 

naming of other variance function
CHISQ.TEST Name for existing CHITEST function that is internally consistent with 

naming of other hypothesis test functions
F.TEST Name for existing FTEST function that is internally consistent with 

naming of other hypothesis functions
T.TEST Name for existing TTEST function that is internally consistent with 

naming of other hypothesis functions
Z.TEST Name for existing ZTEST function that is internally consistent with 

naming of other hypothesis functions

It is possible in Excel 2010 to create formulas by using the older functions. The Excel 
team assigned these functions to a new group called Compatibility Functions. These 
older functions appear at the bottom of the Formula AutoComplete list, but they are 
marked with a different icon than the newer functions. Additionally, the tooltip that 
appears when you point to the older function’s name indicates that the function is 
included for backward compatibility only.
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When a user saves a workbook that contains functions that are new in Excel 2010 to an 
older format, the Compatibility Checker flags the functions and indicates that they will 
return a #NAME? error when the workbook is opened in Excel 2007 or earlier versions.

Summarizing Data by Using Sparklines
In his book Beautiful Evidence, Edward Tufte describes sparklines as “intense, simple, 
wordlike graphics.” In Excel 2010, sparklines take the form of small charts that summarize 
data in a single cell. These small but powerful additions to Excel 2010 enhance the 
program’s reporting and summary capabilities.

Adding a sparkline to a summary worksheet provides context for a single value, such 
as an average or total, displayed in the worksheet. Excel 2010 includes three types of 
sparklines: line, column, and win/loss. A line sparkline is a line chart that displays a data 
trend over time. A column sparkline summarizes data by category, such as sales by 
product type or by month. Finally, a win/loss sparkline indicates whether the points 
in a data series are positive, zero, or negative.
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Filtering PivotTable Data by Using Slicers
With PivotTables, users can summarize large data sets efficiently, such as by rearranging 
values dynamically to emphasize different aspects of the data. It’s often useful to be able 
to limit the data that appears in a PivotTable, so the Excel team included the functionality 
for users to filter PivotTables. The PivotTable indicates that a filter is present for a particular 
data column, but it doesn’t indicate which items are currently displayed or hidden by 
the filter. 

Slicers, which are new in Excel 2010, visually indicate which values appear in a PivotTable 
and which are hidden. They are particularly useful when presenting data to an audience 
that contains visual thinkers who might not be skilled at working with numerical values. 
For example, a corporate analyst could use a Slicer to indicate which months are displayed 
in a PivotTable that summarizes monthly package volumes. 
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Filtering PivotTable Data by Using Search Filters
Excel 2007 introduced several new ways to filter PivotTables. Excel 2010 extends these 
filtering capabilities by introducing search filters. With a search filter, you begin typing 
a sequence of characters that occur in the term (or terms) by which you want to filter. 
As you type in these characters, the PivotTable field’s filter list displays only those terms 
that reflect the values entered into the search filter box.
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Visualizing Data by Using Improved Conditional 
Formats

In Excel 2007, the Excel programming team greatly improved the user’s ability to change a 
cell’s format based on the cell’s contents. One new conditional format, data bars, indicated 
a cell’s relative value by the length of the bar within the cell that contained the value. The 
cell in the range that contained the smallest value displayed a zero-length bar, and the cell 
that contained the largest value displayed a bar that spanned the entire cell width. 

The default behavior of the Excel 2010 data bars has been changed so that bar length is 
calculated in comparison to a baseline value, such as zero. If you prefer, you can display 
values based on the Excel 2007 method or change the comparison value to something 
other than zero. Data bars in Excel 2010 also differ from those in Excel 2007 in that they 
display negative values in a different color than the positive values. In addition, data bars  
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representing negative values extend to the left of the baseline, not to the right. In Excel 2007,  
the conditional formatting engine placed the zero-length data bar in the cell that con-
tained the smallest value, regardless of whether that value was positive or negative.

You have much more control over your data bars’ formatting in Excel 2010 than in Excel 
2007. When you create a data bar in Excel 2010, it has a solid color fill, not a gradient fill 
like the bars in Excel 2007. The gradient fill meant that the color of the Excel 2007 data 
bars faded as the bar extended to the right, making the cells’ relative values harder to 
discern. In Excel 2010 you can select a solid or gradient fill style, apply borders to data 
bars, and change the fill and border colors for both positive and negative values.

Another conditional format introduced in Excel 2007, icon sets, displayed an icon selected 
from a set of three, four, or five icons based on a cell’s value. In Excel 2007, users were 
limited to using the icons within each set and had no ability to create their own sets. In 
Excel 2010, you can create custom icon sets from the icons included in the program and, 
if you prefer, define conditions that, when met, display no icon in the cell.
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Finally, with Excel 2010 you can create conditional formats that refer to values on 
worksheets other than the sheet that contains the cell you’re formatting. In previous 
versions of Excel, users had to create conditional formats that referred to values on the 
same worksheet. 
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Creating and Displaying Math Equations
Scientists and engineers who use Microsoft Excel to support their work often want to 
include equations in their workbooks to help explain how they arrived at their results. 
Excel 2010 includes an updated equation designer with which you can create any 
equation you require. The new editor has several common equations built in, such as 
the quadratic formula and the Pythagorean theorem, but it also contains numerous 
templates that you can use to create custom equations quickly.

Editing Pictures within Excel 2010
When you present data in an Excel workbook, you can insert images into your work-
sheets to illustrate aspects of your data. For example, a shipping company could display 
a scanned image of a tracking label or a properly prepared package. Rather than having 
to edit your images in a separate program and then insert them into your Excel 2010 
workbook, you can insert the image and then modify it by using the editing tools built 
into Excel 2010.

One very helpful capability that is new in Excel 2010 is the ability to remove the back-
ground elements of an image. Removing an image’s background enables you to create 
a composite image in which the foreground elements are placed in front of another 
background. For example, you could focus on a flower’s bloom and remove most of the 
leaves and stem from the photo. After you isolate the foreground image, you can place 
the bloom in front of another background.
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Managing Large Worksheets by Using the 64-bit 
Version of Excel 2010

Some Excel 2010 users, such as business analysts and scientists, will need to manipulate 
extremely large data sets. In some cases, these data sets won’t fit into the more than one 
million rows available in a standard Excel 2010 worksheet. To meet the needs of these 
users, the Excel product team developed the 64-bit version of Excel 2010. The 64-bit 
version takes advantage of the greater amount of random access memory (RAM) avail-
able in newer computers. As a result of its ability to use more RAM than the standard 
32-bit version of Excel 2010, users of the 64-bit version can store hundreds of millions 
of rows of data in a worksheet. In addition, the 64-bit version takes advantage of multi-
core processors to manage its larger data collections efficiently.

All of the techniques described in Microsoft Excel 2010 Step by Step apply to both the 
32-bit and 64-bit versions of the program.

Summarizing Large Data Sets by Using the 
PowerPivot (Project Gemini) Add-In

As businesses collect and maintain increasingly large data sets, the need to analyze that 
data efficiently grows in importance. More powerful computers offer some performance 
improvements, but even the fastest computer takes a long time to process huge data sets 
when using traditional data-handling procedures. A new add-in, PowerPivot for Excel 2010, 
uses enhanced data management techniques to store the data in a computer’s memory, 
rather than forcing the Excel program to read the data from a hard disk. Reading data 
from a computer’s memory instead of a hard disk speeds up the data analysis and display 
operations substantially. Tasks that might have taken minutes to complete in Excel 2010 
without the PowerPivot add-in now take seconds.

PowerPivot relies on the Microsoft SQL Server Analysis Services engine to produce its 
results, so discussion of it is outside the scope of this book. If you would like to learn 
more about PowerPivot, you can visit the team’s blog at blogs.msdn.com/powerpivot/.
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Accessing Your Data from Almost Anywhere by 
Using the Excel Web App and Excel Mobile 2010

As the workforce becomes increasingly mobile, information workers need to access their 
Excel 2010 data as they move around the world. To enable these mobile use scenarios, 
the Excel product team developed the Excel Web App and Excel Mobile 2010. The Excel 
Web App provides a high-fidelity experience that is very similar to the experience of using 
the Excel 2010 desktop application. In addition, you can collaborate with other users in 
real time. The Excel Web App identifies which changes were made by which users and 
enables you to decide which changes to keep and which to reject.

You can use the Excel Web App in Windows Internet Explorer 7 or 8, Safari 4, and 
Firefox 3.5. 

With Excel Mobile 2010, you can access and, in some cases, manipulate your data by 
using a Windows Phone or other mobile device. If you have a Windows Phone running 
Windows Mobile 6.5, you can use Excel Mobile 2010 to view and edit your Excel 2010 
workbooks. If you have another mobile device that provides access to the Web, you can 
use your device’s built-in Web browser to view your files.

A full discussion of the Excel Web App and Excel Mobile 2010 are beyond the scope of 
this book.
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Modifying the Display of the Ribbon
The goal of the Microsoft Office working environment is to make working with Office docu-
ments, including Microsoft Word documents, Excel workbooks, PowerPoint presentations, 
Outlook e-mail messages, and Access database tables, as intuitive as possible. You work 
with an Office document and its contents by giving commands to the program in which 
the document is open. All Office 2010 programs organize commands on a horizontal bar 
called the ribbon, which appears across the top of each program window whether or not 
there is an active document.

Ribbon tabs Ribbon ��o��s

Commands are organized on task-specific tabs of the ribbon, and in feature-specific 
groups on each tab. Commands generally take the form of buttons and lists. Some 
appear in galleries. Some groups have related dialog boxes or task panes that contain 
additional commands. 

Throughout this book, we discuss the commands and ribbon elements associated with 
the program feature being discussed. In this topic, we discuss the general appearance 
of the ribbon, things that affect its appearance, and ways of locating commands that 
aren’t visible on compact views of the ribbon.

Tip  Some older commands no longer appear on the ribbon, but are still available in the 
program. You can make these commands available by adding them to the Quick Access 
Toolbar. For more information, see “Customizing the Excel 2010 Program Window” in 
Chapter 1, “Setting Up a Workbook.”

Dynamic Ribbon Elements
The ribbon is dynamic, meaning that the appearance of commands on the ribbon 
changes as the width of the ribbon changes. A command might be displayed on the 
ribbon in the form of a large button, a small button, a small labeled button, or a list 
entry. As the width of the ribbon decreases, the size, shape, and presence of buttons 
on the ribbon adapt to the available space.
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For example, when sufficient horizontal space is available, the buttons on the Review tab of 
the Word program window are spread out and you’re able to see more of the commands 
available in each group.

Drop-down list
���ll l���l�d ��tton

��r�� ��tton

If you decrease the width of the ribbon, small button labels disappear and entire groups 
of buttons hide under one button that represents the group. Click the group button to 
display a list of the commands available in that group.

Group button ����� un��b���� button�

When the window becomes too narrow to display all the groups, a scroll arrow appears 
at its right end. Click the scroll arrow to display hidden groups.

Scroll arrow

Changing the Width of the Ribbon
The width of the ribbon is dependent on the horizontal space available to it, which 
depends on these three factors:

●	 The width of the program window  Maximizing the program window provides the most 
space for ribbon elements. You can resize the program window by clicking the button in 
its upper-right corner or by dragging the border of a non-maximized window.
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Tip  On a computer running Windows 7, you can maximize the program window by 
dragging its title bar to the top of the screen.

●	 Your screen resolution  Screen resolution is the size of your screen display expressed 
as pixels wide × pixels high. The greater the screen resolution, the greater the amount 
of information that will fit on one screen. Your screen resolution options are depen-
dent on your monitor. At the time of writing, possible screen resolutions range from 
800 × 600 to 2048 × 1152. In the case of the ribbon, the greater the number of pixels 
wide (the first number), the greater the number of buttons that can be shown on the 
ribbon, and the larger those buttons can be.

On a computer running Windows 7, you can change your screen resolution from 
the Screen Resolution window of Control Panel. You set the resolution by dragging 
the pointer on the slider.

●	 The density of your screen display  You might not be aware that you can change the 
magnification of everything that appears on your screen by changing the screen mag-
nification setting in Windows. Setting your screen magnification to 125% makes text 
and user interface elements larger on screen. This increases the legibility of informa-
tion, but means that less fits onto each screen.
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On a computer running Windows 7, you can change the screen magnification from 
the Display window of Control Panel. You can choose one of the standard display 
magnification options, or create another by setting a custom text size.

The screen magnification is directly related to the density of the text elements on 
screen, which is expressed in dots per inch (dpi) or points per inch (ppi). (The terms 
are interchangeable, and in fact are both used in the Windows dialog box in which 
you change the setting.) The greater the dpi, the larger the text and user interface 
elements appear on screen. By default, Windows displays text and screen elements 
at 96 dpi. Choosing the Medium - 125% display setting changes the dpi of text and 
screen elements to 120 dpi. You can choose a custom setting of up to 500% mag-
nification, or 480 dpi, in the Custom DPI Setting dialog box. The list allows you to 
choose a magnification of up to 200%.You can choose a greater magnification by 
dragging across the ruler from left to right.
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See Also  For more information about display settings, refer to Windows 7 Step by Step 
(Microsoft Press, 2009), Windows Vista Step by Step (Microsoft Press, 2006), or Windows XP 
Step by Step (Microsoft Press, 2002) by Joan Lambert Preppernau and Joyce Cox.

Adapting Exercise Steps
The screen images shown in the exercises in this book were captured at a screen resolution 
of 1024 × 768, at 100% magnification, and the default text size (96 dpi). If any of your set-
tings are different, the ribbon on your screen might not look the same as the one shown 
in the book. For example, you might see more or fewer buttons in each of the groups, the 
buttons you see might be represented by larger or smaller icons than those shown, or the 
group might be represented by a button that you click to display the group’s commands.

When we instruct you to give a command from the ribbon in an exercise, we do it in this 
format:

●	 On the Insert tab, in the Illustrations group, click the Chart button.

If the command is in a list, we give the instruction in this format:

●	 On the Page Layout tab, in the Page Setup group, click the Breaks button and 
then, in the list, click Page.

The first time we instruct you to click a specific button in each exercise, we display an 
image of the button in the page margin to the left of the exercise step.

If differences between your display settings and ours cause a button on your screen to 
look different from the one shown in the book, you can easily adapt the steps to locate 
the command. First, click the specified tab. Then locate the specified group. If a group 
has been collapsed into a group list or group button, click the list or button to display 
the group’s commands. Finally, look for a button that features the same icon in a larger 
or smaller size than that shown in the book. If necessary, point to buttons in the group 
to display their names in ScreenTips.

If you prefer not to have to adapt the steps, set up your screen to match ours while you 
read and work through the exercises in the book.
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Features and Conventions  
of This Book

This book has been designed to lead you step by step through all the tasks you’re most 
likely to want to perform in Microsoft Excel 2010. If you start at the beginning and work 
your way through all the exercises, you’ll gain enough proficiency to be able to create 
and work with all the common types of Excel workbooks. However, each topic is self 
contained. If you’ve worked with a previous version of Excel, or if you completed all the 
exercises and later need help remembering how to perform a procedure, the following 
features of this book will help you locate specific information:

●	 Detailed table of contents  Search the listing of the topics and sidebars within 
each chapter.

●	 Chapter thumb tabs  Easily locate the beginning of the chapter you want.

●	 Topic-specific running heads  Within a chapter, quickly locate the topic you 
want by looking at the running heads at the top of odd-numbered pages.

●	 Glossary  Look up the meaning of a word or the definition of a concept.

●	 Detailed index  Look up specific tasks and features in the index, which has been 
carefully crafted with the reader in mind.

You can save time when reading this book by understanding how the Step by Step series 
shows exercise instructions, keys to press, buttons to click, and other information.
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Convention Meaning
SET UP This paragraph preceding a step-by-step exercise indicates the 

practice files that you will use when working through the exercise. It 
also indicates any requirements you should attend to or actions you 
should take before beginning the exercise.

CLEAN UP This paragraph following a step-by-step exercise provides instructions 
for saving and closing open files or programs before moving on to 
another topic. It also suggests ways to reverse any changes you made 
to your computer while working through the exercise.

1

2

Numbered steps guide you through hands-on exercises in each topic, 
as well as procedures in sidebars and expository text.

See Also This paragraph directs you to more information about a topic in this 
book or elsewhere.

Troubleshooting This paragraph alerts you to a common problem and provides 
guidance for fixing it.

Tip This paragraph provides a helpful hint or shortcut that makes working 
through a task easier.

Important This paragraph points out information that you need to know to 
complete a procedure.

Keyboard Shortcut This paragraph provides information about an available keyboard 
shortcut for the preceding task.

Ctrl+B A plus sign (+) between two keys means that you must press those 
keys at the same time. For example, “Press Ctrl+B” means that you 
should hold down the Ctrl key while you press the B key.
Pictures of buttons appear in the margin the first time the button is 
used in a chapter.

Bold In exercises that begin with SET UP information, bold type displays text 
that you should type; the names of program elements, such as buttons, 
commands, windows, and dialog boxes; and files, folders, or text that 
you interact with in the steps.
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Using the Practice Files
Before you can complete the exercises in this book, you need to copy the book’s practice 
files to your computer. These practice files, and other information, can be downloaded 
from the book’s detail page, located at:

http://go.microsoft.com/fwlink/?Linkid=191751

Display the detail page in your Web browser and follow the instructions for downloading 
the files.

Important  The Microsoft Excel 2010 program is not available from this Web site. You should 
purchase and install that program before using this book.

The following table lists the practice files for this book.

Chapter File
Chapter 1:  
Setting Up a Workbook

ExceptionSummary_start.xlsx
ExceptionTracking_start.xlsx
MisroutedPackages_start.xlsx
PackageCounts_start.xlsx
RouteVolume_start.xlsx

Chapter 2:  
Working with Data and Excel Tables

2010Q1ShipmentsByCategory_start.xlsx
AverageDeliveries_start.xlsx
DriverSortTimes_start.xlsx
Series_start.xlsx
ServiceLevels_start.xlsx

Chapter 3:  
Performing Calculations on Data

ConveyerBid_start.xlsx 
ITExpenses_start.xlsx
PackagingCosts_start.xlsx
VehicleMiles_start.xlsx

(continued)
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Chapter File
Chapter 4:  
Changing Workbook Appearance

CallCenter_start.xlsx
Dashboard_start.xlsx
ExecutiveSearch_start.xlsx
HourlyExceptions_start.xlsx
HourlyTracking_start.xlsx
phone.jpg
texture.jpg
VehicleMileSummary_start.xlsx

Chapter 5:  
Focusing on Specific Data by Using Filters

Credit_start.xlsx
ForFollowUp_start.xlsx
PackageExceptions_start.xlsx

Chapter 6:  
Reordering and Summarizing Data

GroupByQuarter_start.xlsx
ShipmentLog_start.xlsx
ShippingSummary_start.xlsx

Chapter 7:  
Combining Data from Multiple Sources

Consolidate_start.xlsx
DailyCallSummary_start.xlsx
FebruaryCalls_start.xlsx
FleetOperatingCosts_start.xlsx
JanuaryCalls_start.xlsx
OperatingExpenseDashboard_start.xlsx

Chapter 8:  
Analyzing Alternative Data Sets

2DayScenario_start.xlsx
AdBuy_start.xlsx
DriverSortTimes_start.xlsx
MultipleScenarios_start.xlsx
TargetValues_start.xlsx

Chapter 9:  
Creating Dynamic Lists by Using PivotTables

Creating_start.txt
Creating_start.xlsx
Editing_start.xlsx
Focusing_start.xlsx
Formatting_start.xlsx
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Chapter File
Chapter 10:  
Creating Charts and Graphics

FutureVolumes_start.xlsx
OrgChart_start.xlsx
RevenueAnalysis_start.xlsx
RevenueSummary_start.xlsx
Shapes_start.xlsx
VolumebyCenter_start.xlsx
YearlyPackageVolume_start.xlsx

Chapter 11:  
Printing

ConsolidatedMessenger.png
CorporateRevenue_start.xlsx
HourlyPickups_start.xlsx
PickupsByHour_start.xlsx
RevenueByCustomer_start.xlsx
SummaryByCustomer_start.xlsx

Chapter 12:  
Automating Repetitive Tasks by Using Macros

PerformanceDashboard_start.xlsm
RunOnOpen_start.xlsm
VolumeHighlights_start.xlsm
YearlySalesSummary_start.xlsx

Chapter 13:  
Working with Other Microsoft Office Programs

2010YearlyRevenueSummary_start.pptx
Hyperlink_start.xlsx
LevelDescriptions_start.xlsx
RevenueByServiceLevel_start.xlsx
RevenueChart_start.xlsx
RevenueSummary_start.pptx
SummaryPresentation_start.xlsx

Chapter 14:  
Collaborating with Colleagues

CostProjections_start.xlsx
ProjectionChangeTracking_start.xlsx
ProjectionsForComment_start.xlsx
ProjectionsSigned_start.xlsx
SecureInfo_start.xlsx
ShipmentSummary_start.xlsx
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Your Companion eBook
The eBook edition of this book allows you to:

●	 Search the full text

●	 Print

●	 Copy and Paste

To download your eBook, please see the instruction page at the back of this book.
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Getting Help
Every effort has been made to ensure the accuracy of this book. If you do run into 
problems, please contact the sources listed in the following topics.

Getting Help with This Book
If your question or issue concerns the content of this book or its practice files, please 
first consult the book’s errata page, which can be accessed at:

http://go.microsoft.com/fwlink/?Linkid=191751

This page provides information about known errors and corrections to the book. If 
you do not find your answer on the errata page, send your question or comment to 
Microsoft Press Technical Support at:

mspinput@microsoft.com

Getting Help with Excel 2010
If your question is about Microsoft Excel 2010, and not about the content of this book, 
your first recourse is the Excel Help system. This system is a combination of tools and files 
stored on your computer when you installed Excel and, if your computer is connected to 
the Internet, information available from Office.com. You can find general or specific Help 
information in the following ways:

●	 To find out about an item on the screen, you can display a ScreenTip. For example, to 
display a ScreenTip for a button, point to the button without clicking it. The ScreenTip 
gives the button’s name, the associated keyboard shortcut if there is one, and unless 
you specify otherwise, a description of what the button does when you click it.

●	 In the Excel program window, you can click the Microsoft Excel Help button (a 
question mark in a blue circle) at the right end of the ribbon to display the Excel 
Help window. 

●	 After opening a dialog box, you can click the Help button (also a question mark) at 
the right end of the dialog box title bar to display the Excel Help window. Sometimes, 
topics related to the functions of that dialog box are already identified in the window.
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To practice getting help, you can work through the following exercise.

SET UP  You don’t need any practice files to complete this exercise. Start Excel, and 
then follow the steps.

	 1.	 At the right end of the ribbon, click the Microsoft Excel Help button.

The Excel Help window opens.

If you are connected to the Internet, clicking any of the buttons below the Microsoft 
Office banner (Downloads, Images, and Templates) takes you to a corresponding 
page of the Office Web site.

Tip  You can maximize the window or adjust its size by dragging the handle in the 
lower-right corner. You can change the size of the font by clicking the Change Font 
Size button on the toolbar.

	 2.	 Below the bulleted list under Browse Excel 2010 support, click see all.

The window changes to display a list of help topics.
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	 3.	 In the list of topics, click Activating Excel.

Excel Help displays a list of topics related to activating Microsoft Office programs. 
You can click any topic to display the corresponding information.

	 4.	 On the toolbar, click the Show Table of Contents button.

The window expands to accommodate two panes. The Table Of Contents task 
pane appears on the left, organized by category, like the table of contents in a 
book. If you’re connected to the Internet, Excel displays categories, topics, and 
training available from the Office Online Web site as well as those stored on 
your computer. Clicking any category (represented by a book icon) displays that 
category’s topics (represented by help icons).

	 5.	 In the Table of Contents task pane, click a few categories and topics. Then click the 
Back and Forward buttons to move among the topics you have already viewed.

	 6.	 At the right end of the Table of Contents title bar, click the Close button.

	 7.	 At the top of the Excel Help window, click the Type words to search for box, 
type saving, and then press the Enter key.

The Excel Help window displays topics related to the word you typed. Next and 
Back buttons appear to make it easier to search for the topic you want.
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	 8.	 In the results list, click the Recover earlier versions of a file in Office 2010 topic.

The selected topic appears in the Excel Help window.

	 9.	 Below the title at the top of the topic, click Show All.

Excel displays any hidden auxiliary information available in the topic and changes 
the Show All button to Hide All. You can jump to related information by clicking 
hyperlinks identified by blue text.

Tip  You can click the Print button on the toolbar to print a topic. Only the displayed 
information is printed.

CLEAN UP  Click the Close button at the right end of the Excel Help window.
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More Information
If your question is about Microsoft Excel 2010 or another Microsoft software product 
and you cannot find the answer in the product’s Help system, please search the  
appropriate product solution center or the Microsoft Knowledge Base at:

support.microsoft.com

In the United States, Microsoft software product support issues not covered by the 
Microsoft Knowledge Base are addressed by Microsoft Product Support Services. 
Location-specific software support options are available from:

support.microsoft.com/gp/selfoverview/
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	 4	 Changing Workbook 
		  Appearance
In this chapter, you will learn how to
✔	 Format cells.
✔	 Define styles.
✔	 Apply workbook themes and Excel table styles.
✔	 Make numbers easier to read.
✔	 Change the appearance of data based on its value.
✔	 Add images to worksheets.

Entering data into a workbook efficiently saves you time, but you must also ensure  
that your data is easy to read. Microsoft Excel 2010 gives you a wide variety of ways  
to make your data easier to understand; for example, you can change the font, character 
size, or color used to present a cell’s contents. Changing how data appears on a work-
sheet helps set the contents of a cell apart from the contents of surrounding cells. The 
simplest example of that concept is a data label. If a column on your worksheet contains 
a list of days, you can easily set apart a label (for example, Day) by presenting it in bold 
type that’s noticeably larger than the type used to present the data to which it refers. To 
save time, you can define a number of custom formats and then apply them quickly 
to the desired cells.

You might also want to specially format a cell’s contents to reflect the value in that cell. 
For example, Lori Penor, the chief operating officer of Consolidated Messenger, might 
want to create a worksheet that displays the percentage of improperly delivered packages 
from each regional distribution center. If that percentage exceeds a threshold, she could 
have Excel display a red traffic light icon, indicating that the center’s performance is out 
of tolerance and requires attention. 
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In this chapter, you’ll learn how to change the appearance of data, apply existing formats 
to data, make numbers easier to read, change data’s appearance based on its value, and 
add images to worksheets.

Practice Files  Before you can complete the exercises in this chapter, you need to copy 
the book’s practice files to your computer. The practice files you’ll use to complete the 
exercises in this chapter are in the Chapter04 practice file folder. A complete list of 
practice files is provided in “Using the Practice Files” at the beginning of this book.

Formatting Cells
Excel spreadsheets can hold and process lots of data, but when you manage numerous 
spreadsheets it can be hard to remember from a worksheet’s title exactly what data is 
kept in that worksheet. Data labels give you and your colleagues information about data 
in a worksheet, but it’s important to format the labels so that they stand out visually. To 
make your data labels or any other data stand out, you can change the format of the 
cells that hold your data.



Most of the tools you need to change a cell’s format can be found on the Home tab. You 
can apply the formatting represented on a button by selecting the cells you want to apply 
the style to and then clicking that button. If you want to set your data labels apart by 
making them appear bold, click the Bold button. If you have already made a cell’s con-
tents bold, selecting the cell and clicking the Bold button will remove the formatting.

Tip  Deleting a cell’s contents doesn’t delete the cell’s formatting. To delete a selected cell’s 
formatting, on the Home tab, in the Editing group, click the Clear button (which looks like an 
eraser), and then click Clear Formats. Clicking Clear All from the same list will remove the cell’s 
contents and formatting.

Buttons in the Home tab’s Font group that give you choices, such as Font Color, have 
an arrow at the right edge of the button. Clicking the arrow displays a list of options 
accessible for that button, such as the fonts available on your system or the colors you 
can assign to a cell.

	 Formatting Cells    85



86    Chapter 4  Changing Workbook Appearance

Another way you can make a cell stand apart from its neighbors is to add a border around 
the cell. To place a border around one or more cells, select the cells, and then choose the 
border type you want by selecting from the Border list in the Font group. Excel does 
provide more options: To display the full range of border types and styles, in the Border 
list, click More Borders. The Border page of the Format Cells dialog box contains the full 
range of tools you can use to define your cells’ borders.

You can also make a group of cells stand apart from its neighbors by changing its shading, 
which is the color that fills the cells. On a worksheet that tracks total package volume for 
the past month, Lori Penor could change the fill color of the cells holding her data labels 
to make the labels stand out even more than by changing the labels’ text formatting.

Tip  You can display the most commonly used formatting controls by right-clicking a selected 
range. When you do, a Mini Toolbar containing a subset of the Home tab formatting tools 
appears above the shortcut menu.

If you want to change the attributes of every cell in a row or column, you can click the 
header of the row or column you want to modify and then select your desired format.



One task you can’t perform by using the tools on the Home tab is to change the stan-
dard font for a workbook, which is used in the Name box and on the formula bar. The 
standard font when you install Excel is Calibri, a simple font that is easy to read on a 
computer screen and on the printed page. If you want to choose another font, click the  
File tab, and then click Options. On the General page of the Excel Options dialog box, set 
the values in the Use This Font and Font Size list boxes to pick your new display font.

Important  The new standard font doesn’t take effect until you exit Excel and restart the 
program.

In this exercise, you’ll emphasize a worksheet’s title by changing the format of cell data, 
adding a border to a cell range, and then changing a cell range’s fill color. After those 
tasks are complete, you’ll change the default font for the workbook.

SET UP  You need the VehicleMileSummary_start workbook located in your 
Chapter04 practice file folder to complete this exercise. Start Excel, open the 
VehicleMileSummary_start workbook, and save it as VehicleMileSummary. Then 
follow the steps. 

	 1.	 Click cell D2.

	 2.	 On the Home tab, in the Font group, click the Bold button.

Excel displays the cell’s contents in bold type.

	 3.	 In the Font group, click the Font Size arrow, and then in the list, click 18.

Excel increases the size of the text in cell D2.

	 Formatting Cells    87



88    Chapter 4  Changing Workbook Appearance

	 4.	 Click cell B5, hold down the Ctrl key, and click cell C4 to select the non-contiguous 
cells.

	 5.	 On the Home tab, in the Font group, click the Bold button.

Excel displays the cells’ contents in bold type.

	 6.	 Select the cell ranges B6:B15 and C5:H5.

	 7.	 In the Font group, click the Italic button.

Excel displays the cells’ contents in italic type.

	 8.	 Select the cell range C6:H15.

	 9.	 In the Font group, click the Border arrow, and then in the list, click Outside 
Borders.

Excel places a border around the outside edge of the selected cells.

	 10.	 Select the cell range B4:H15.

	 11.	 In the Border list, click Thick Box Border.

Excel places a thick border around the outside edge of the selected cells.

	 12.	 Select the cell ranges B4:B15 and C4:H5.

	 13.	 In the Font group, click the Fill Color arrow, and then in the Standard Colors area 
of the color palette, click the yellow button.

Excel changes the selected cells’ background color to yellow.



Troubleshooting  The appearance of buttons and groups on the ribbon changes depending 
on the width of the program window. For information about changing the appearance of 
the ribbon to match our screen images, see “Modifying the Display of the Ribbon” at the 
beginning of this book.

	 14.	 Click the File tab, and then click Options.

The Excel Options dialog box opens.

	 15.	 If necessary, click General to display the General page.

	 16.	 In the When creating new workbooks area, in the Use this font list, click Verdana.

Verdana appears in the Use This Font field.

	 17.	 Click Cancel.

The Excel Options dialog box closes without saving your change.

CLEAN UP  Save the VehicleMileSummary workbook, and then close it.
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Defining Styles
As you work with Excel, you will probably develop preferred formats for data labels, 
titles, and other worksheet elements. Instead of adding a format’s characteristics one 
element at a time to the target cells, you can have Excel store the format and recall it 
as needed. You can find the predefined formats by displaying the Home tab, and then  
in the Styles group, clicking Cell Styles.

Clicking a style from the Cell Styles gallery applies the style to the selected cells, 
but Excel also displays a live preview of a format when you point to it. If none of the 
existing styles is what you want, you can create your own style by clicking New Cell 
Style at the bottom of the gallery to display the Style dialog box. In the Style dialog 
box, type the name of your new style in the Style Name field, and then click Format. 
The Format Cells dialog box opens.



After you set the characteristics of your new style, click OK to make your style available 
in the Cell Styles gallery. If you ever want to delete a custom style, display the Cell Styles 
gallery, right-click the style, and then click Delete.

The Style dialog box is quite versatile, but it’s overkill if all you want to do is apply for-
matting changes you made to a cell to the contents of another cell. To do so, use the 
Format Painter button, found in the Home tab’s Clipboard group. Just click the cell that 
has the format you want to copy, click the Format Painter button, and select the target 
cells to have Excel apply the copied format to the target range.

Tip  If you want to apply the same formatting to multiple cells by using the Format Painter 
button, double-click the Format Painter button and then click the cells to which you want to 
apply the formatting. When you’re done applying the formatting, press the Esc key.

In this exercise, you’ll create a style and apply the new style to a data label. 

SET UP  You need the HourlyExceptions_start workbook located in your Chapter04 
practice file folder to complete this exercise. Open the HourlyExceptions_start 
workbook, and save it as HourlyExceptions. Then follow the steps. 

	 1.	 On the Home tab, in the Styles group, click Cell Styles, and then click New Cell Style.

The Style dialog box opens.
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	 2.	 In the Style name field, type Crosstab Column Heading.

	 3.	 Click the Format button.

The Format Cells dialog box opens.

	 4.	 Click the Alignment tab.



	 5.	 In the Horizontal list, click Center.

Center appears in the Horizontal field.

	 6.	 Click the Font tab.

	 7.	 In the Font style list, click Italic.

The text in the Preview pane appears in italicized text.

	 8.	 Click the Number tab.

The Number page of the Format Cells dialog box is displayed.

	 9.	 In the Category list, click Time.

The available time formats appear.

	 10.	 In the Type pane, click 1:30 PM.

	 11.	 Click OK to save your changes.

The Format Cells dialog box closes, and your new style’s definition appears in the 
Style dialog box.

	 12.	 Click OK.

The Style dialog box closes.

	 13.	 Select cells C4:N4.
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	 14.	 On the Home tab, in the Styles group, click Cell Styles.

Your new style appears at the top of the gallery, in the Custom group.

	 15.	 Click the Crosstab Column Heading style.

Excel applies your new style to the selected cells.

CLEAN UP  Save the HourlyExceptions workbook, and then close it.

Applying Workbook Themes and Excel Table Styles
Microsoft Office 2010 includes powerful design tools that enable you to create attractive, 
professional documents quickly. The Excel product team implemented the new design 
capabilities by defining workbook themes and Excel table styles. A theme is a way to 
specify the fonts, colors, and graphic effects that appear in a workbook. Excel comes 
with many themes installed.

To apply an existing workbook theme, display the Page Layout tab. Then, in the Themes 
group, click Themes, and click the theme you want to apply to your workbook. By default, 
Excel applies the Office theme to your workbooks. 



When you want to format a workbook element, Excel displays colors that are available 
within the active theme. For example, selecting a worksheet cell and then clicking the Font 
Color button’s arrow displays a palette of colors you can use. The theme colors appear in 
the top segment of the color palette—the standard colors and the More Colors link, which 
displays the Colors dialog box, appear at the bottom of the palette. If you format workbook 
elements using colors from the Theme Colors area of the color palette, applying a different 
theme changes that object’s colors.
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You can change a theme’s colors, fonts, and graphic effects by displaying the Page Layout 
tab and then, in the Themes group, selecting new values from the Colors, Fonts, and 
Effects lists. To save your changes as a new theme, display the Page Layout tab, and in the 
Themes group, click Themes, and then click Save Current Theme. Use the controls in the 
Save Current Theme dialog box that opens to record your theme for later use. Later, when 
you click the Themes button, your custom theme will appear at the top of the gallery.

Tip  When you save a theme, you save it as an Office Theme file. You can apply the theme to 
other Office 2010 documents as well.

Just as you can define and apply themes to entire workbooks, you can apply and 
define Excel table styles. You select an Excel table’s initial style when you create it; 
to create a new style, display the Home tab, and in the Styles group, click Format As 
Table. In the Format As Table gallery, click New Table Style to display the New Table 
Quick Style dialog box.



Type a name for the new style, select the first table element you want to format, and 
then click Format to display the Format Cells dialog box. Define the element’s formatting, 
and then click OK. When the New Table Quick Style dialog box reopens, its Preview pane 
displays the overall table style and the Element Formatting area describes the selected 
element’s appearance. Also, in the Table Element list, Excel displays the element’s name 
in bold to indicate it has been changed. To make the new style the default for new Excel 
tables created in the current workbook, select the Set As Default Table Quick Style For 
This Document check box. When you click OK, Excel saves the new table style.

Tip  To remove formatting from a table element, click the name of the table element and then 
click the Clear button.

In this exercise, you’ll create a new workbook theme, change a workbook’s theme, create 
a new table style, and apply the new style to an Excel table.

SET UP  You need the HourlyTracking_start workbook located in your Chapter04 
practice file folder to complete this exercise. Open the HourlyTracking_start 
workbook, and save it as HourlyTracking. Then follow the steps. 

	 1.	 If necessary, click any cell in the Excel table.

	 2.	 On the Home tab, in the Styles group, click Format as Table, and then click the 
style at the upper-left corner of the Table Styles gallery.

Excel applies the style to the table.

	 3.	 On the Home tab, in the Styles group, click Format as Table, and then click New 
Table Style.

The New Table Quick Style dialog box opens.

	 4.	 In the Name field, type Exception Default.

	 5.	 In the Table Element list, click Header Row.

	 6.	 Click Format.

The Format Cells dialog box opens.
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	 7.	 Click the Fill tab.

The Fill page is displayed.

	 8.	 In the first row of color squares, just below the No Color button, click the third 
square from the left.

The new background color appears in the Sample pane of the dialog box.

	 9.	 Click OK.



The Format Cells dialog box closes. When the New Table Quick Style dialog box 
reopens, the Header Row table element appears in bold, and the Preview pane’s 
header row is shaded.

	 10.	 In the Table Element list, click Second Row Stripe, and then click Format.

The Format Cells dialog box opens.

	 11.	 Just below the No Color button, click the third square from the left again.

The new background color appears in the Sample pane of the dialog box.

	 12.	 Click OK.

The Format Cells dialog box closes. When the New Table Quick Style dialog box 
reopens, the Second Row Stripe table element appears in bold, and every second 
row is shaded in the Preview pane.
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	 13.	 Click OK.

The New Table Quick Style dialog box closes.

	 14.	 On the Home tab, in the Styles group, click Format as Table. In the gallery, in the 
Custom area, click the new format.

Excel applies the new format.

	 15.	 On the Page Layout tab, in the Themes group, click the Fonts arrow, and then in 
the list, click Verdana.

Excel changes the theme’s font to Verdana (which is part of the Aspect font set).

	 16.	 In the Themes group, click the Themes button, and then click Save Current 
Theme.

The Save Current Theme dialog box opens.



	 17.	 In the File name field, type Verdana Office, and then click Save.

Excel saves your theme.

	 18.	 In the Themes group, click the Themes button, and then click Origin.

Excel applies the new theme to your workbook.

CLEAN UP  Save the HourlyTracking workbook, and then close it.

Making Numbers Easier to Read
Changing the format of the cells in your worksheet can make your data much easier to read, 
both by setting data labels apart from the actual data and by adding borders to define the 
boundaries between labels and data even more clearly. Of course, using formatting options 
to change the font and appearance of a cell’s contents doesn’t help with idiosyncratic data 
types such as dates, phone numbers, or currency values.
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As an example, consider U.S. phone numbers. These numbers are 10 digits long and have 
a 3-digit area code, a 3-digit exchange, and a 4-digit line number written in the form (###) 
###-####. Although it’s certainly possible to type a phone number with the expected for-
matting in a cell, it’s much simpler to type a sequence of 10 digits and have Excel change 
the data’s appearance.

You can tell Excel to expect a phone number in a cell by opening the Format Cells 
dialog box to the Number page and displaying the formats available for the Special 
category.

Clicking Phone Number in the Type list tells Excel to format 10-digit numbers in the 
standard phone number format. You can see this in operation if you compare the con-
tents of the active cell and the contents of the formula box for a cell with the Phone 
Number formatting.



Troubleshooting  If you type a 9-digit number in a field that expects a phone number, you 
won’t see an error message; instead, you’ll see a 2-digit area code. For example, the number 
425550012 would be displayed as (42) 555-0012. An 11-digit number would be displayed with 
a 4-digit area code. If the phone number doesn’t look right, you probably left out a digit or 
included an extra one, so you should make sure your entry is correct.

Just as you can instruct Excel to expect a phone number in a cell, you can also have it 
expect a date or a currency amount. You can make those changes from the Format Cells 
dialog box by choosing either the Date category or the Currency category. The Date 
category enables you to pick the format for the date (and determine whether the date’s 
appearance changes due to the Locale setting of the operating system on the computer 
viewing the workbook). In a similar vein, selecting the Currency category displays controls 
to set the number of places after the decimal point, the currency symbol to use, and the 
way in which Excel should display negative numbers.

Tip  The Excel user interface enables you to make the most common format changes by 
displaying the Home tab of the ribbon and then, in the Number group, either clicking a 
button representing a built-in format or selecting a format from the Number Format list.

You can also create a custom numeric format to add a word or phrase to a number 
in a cell. For example, you can add the phrase per month to a cell with a formula that 
calculates average monthly sales for a year to ensure that you and your colleagues will 
recognize the figure as a monthly average. To create a custom number format, click the 
Home tab, and then click the Number dialog box launcher (found at the bottom right 
corner of the Number group on the ribbon) to display the Format Cells dialog box. 
Then, if necessary, click the Number tab.

In the Category list, click Custom to display the available custom number formats in the 
Type list. You can then click the base format you want and modify it in the Type box. For 
example, clicking the 0.00 format causes Excel to format any number in a cell with two 
digits to the right of the decimal point.

Tip  The zeros in the format indicate that the position in the format can accept any number as 
a valid value.
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To customize the format, click in the Type box and add any symbols or text you want to 
the format. For example, typing a dollar ($) sign to the left of the existing format and then 
typing “per month” (including quote marks) to the right of the existing format causes the 
number 1500 to be displayed as $1500.00 per month.

Important  You need to enclose any text to be displayed as part of the format in quotes so 
that Excel recognizes the text as a string to be displayed in the cell.

In this exercise, you’ll assign date, phone number, and currency formats to ranges of cells. 

SET UP  You need the ExecutiveSearch_start workbook located in your Chapter04 
practice file folder to complete this exercise. Open the ExecutiveSearch_start 
workbook, and save it as ExecutiveSearch. Then follow the steps. 

	 1.	 Click cell A3.

	 2.	 On the Home tab, click the Font dialog box launcher.

The Format Cells dialog box opens.

	 3.	 If necessary, click the Number tab.

	 4.	 In the Category list, click Date.

The Type list appears with a list of date formats.

	 5.	 In the Type list, click 3/14/01.



	 6.	 Click OK to assign the chosen format to the cell.

Excel displays the contents of cell A3 to reflect the new format.

	 7.	 Click cell G3.

	 8.	 On the Home tab, in the Number group, click the Number Format button’s down 
arrow and then click More Number Formats.

	 9.	 If necessary, click the Number tab in the Format Cells dialog box.

	 10.	 In the Category list, click Special.

The Type list appears with a list of special formats.

	 11.	 In the Type list, click Phone Number, and then click OK.

Excel displays the contents of the cell as (425) 555-0102, matching the format you 
selected, and the Format Cells dialog box closes.

	 12.	 Click cell H3.

	 13.	 Click the Font dialog box launcher.

	 14.	 If necessary, click the Number tab in the Format Cells dialog box.

	 15.	 In the Category list, click Custom.

The contents of the Type list are updated to reflect your choice.
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	 16.	 In the Type list, click the #,##0 item.

#,##0 appears in the Type box.

	 17.	 In the Type box, click to the left of the existing format, and type $. Then click to 
the right of the format, and type “ before bonuses” (note the space after the 
opening quote).

	 18.	 Click OK to close the dialog box.

CLEAN UP  Save the ExecutiveSearch workbook, and then close it.

Changing the Appearance of Data  
Based on Its Value

Recording package volumes, vehicle miles, and other business data in a worksheet enables 
you to make important decisions about your operations. And as you saw earlier in this 
chapter, you can change the appearance of data labels and the worksheet itself to make 
interpreting your data easier.

Another way you can make your data easier to interpret is to have Excel change the 
appearance of your data based on its value. These formats are called conditional for-
mats because the data must meet certain conditions, defined in conditional formatting 
rules, to have a format applied to it. For example, if chief operating officer Lori Penor 
wanted to highlight any Thursdays with higher-than-average weekday package volumes, 
she could define a conditional format that tests the value in the cell recording total sales 
and changes the format of the cell’s contents when the condition is met.

To create a conditional format, you select the cells to which you want to apply the format, 
display the Home tab, and then in the Styles group, click Conditional Formatting to display 
a menu of possible conditional formats. In Excel, you can define conditional formats that 
change how the program displays data in cells that contain values above or below the aver-
age values of the related cells, that contain values near the top or bottom of the value range, 
or that contain values duplicated elsewhere in the selected range.



When you select which kind of condition to create, Excel displays a dialog box that contains 
fields and controls you can use to define your rule. To display all of the rules for the selected 
cells, display the Home tab, and then in the Styles group, click Conditional Formatting. On 
the menu, click Manage Rules to display the Conditional Formatting Rules Manager.

The Conditional Formatting Rules Manager enables you to control your conditional formats 
in the following ways:

●	 Create a new rule by clicking the New Rule button.

●	 Change a rule by clicking the rule and then clicking the Edit Rule button.

●	 Remove a rule by clicking the rule and then clicking the Delete Rule button.

●	 Move a rule up or down in the order by clicking the rule and then clicking the 
Move Up button or Move Down button.

●	 Control whether Excel continues evaluating conditional formats after it finds a rule 
to apply by selecting or clearing a rule’s Stop If True check box.

●	 Save any new rules and close the Conditional Formatting Rules Manager by 
clicking OK.

●	 Save any new rules without closing the Conditional Formatting Rules Manager by 
clicking Apply.

●	 Discard any unsaved changes by clicking Cancel.

Tip  Clicking the New Rule button in the Conditional Formatting Rules Manager opens the 
New Formatting Rule dialog box. The commands in the New Formatting Rule dialog box 
duplicate the options displayed when you click the Conditional Formatting button in the 
Styles group on the Home tab.
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After you create a rule, you can change the format applied if the rule is true by clicking 
the rule and then clicking the Edit Rule button to display the Edit Formatting Rule dialog 
box. In that dialog box, click the Format button to display the Format Cells dialog box. 
After you define your format, click OK to display the rule.

Important  Excel doesn’t check to make sure that your conditions are logically consistent, so 
you need to be sure that you plan and enter your conditions correctly.

Excel also enables you to create three other types of conditional formats: data bars, 
color scales, and icon sets. Data bars summarize the relative magnitude of values in a 
cell range by extending a band of color across the cell.

You can create two types of data bars in Excel 2010: solid fill and gradient fill. When  
data bars were introduced in Excel 2007, they filled cells with a color band that decreased  
in intensity as it moved across the cell. This gradient fill pattern made it a bit difficult to 
determine the relative length of two data bars because the end points weren’t as distinct 
as they would have been if the bars were a solid color. Excel 2010 enables you to choose 
between a solid fill pattern, which makes the right edge of the bars easier to discern, 



and a gradient fill, which you can use if you share your workbook with colleagues who 
use Excel 2007.

Excel also draws data bars differently than was done in Excel 2007. Excel 2007 drew a very 
short data bar for the lowest value in a range and a very long data bar for the highest 
value. The problem was that similar values could be represented by data bars of very 
different lengths if there wasn’t much variance among the values in the conditionally 
formatted range. In Excel 2010, data bars compare values based on their distance from 
zero, so similar values are summarized using data bars of similar lengths.

Tip  Excel 2010 data bars summarize negative values by using bars that extend to the left of 
a baseline that the program draws in a cell. You can control how your data bars summarize 
negative values by clicking the Negative Value And Axis button, which can be accessed from 
either the New Formatting Rule dialog box or the Edit Formatting Rule dialog box.

Color scales compare the relative magnitude of values in a cell range by applying colors 
from a two-color or three-color set to your cells. The intensity of a cell’s color reflects the 
value’s tendency toward the top or bottom of the values in the range.

Icon sets are collections of three, four, or five images that Excel displays when certain 
rules are met. 

When icon sets were introduced in Excel 2007, you could apply an icon set as a whole, 
but you couldn’t create custom icon sets or choose to have Excel 2007 display no icon if 
the value in a cell met a criterion. In Excel 2010, you can display any icon from any set for 
any criterion or display no icon.

When you click a color scale or icon set in the Conditional Formatting Rules Manager 
and then click the Edit Rule button, you can control when Excel applies a color or icon 
to your data.
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Important  Be sure to not include cells that contain summary formulas in your conditionally 
formatted ranges. The values, which could be much higher or lower than your regular cell 
data, could throw off your comparisons.

In this exercise, you’ll create a series of conditional formats to change the appearance of 
data in worksheet cells displaying the package volume and delivery exception rates of a 
regional distribution center.

SET UP  You need the Dashboard_start workbook located in your Chapter04 practice 
file folder to complete this exercise. Open the Dashboard_start workbook, and save it 
as Dashboard. Then follow the steps. 

	 1.	 Select cells C4:C12.

	 2.	 On the Home tab, in the Styles group, click Conditional Formatting. On the menu, 
point to Color Scales, and then in the top row of the palette, click the second pattern 
from the left.

Excel formats the selected range.

	 3.	 Select cells F4:F12.



	 4.	 On the Home tab, in the Styles group, click Conditional Formatting. On the 
menu, point to Data Bars, and then, in the Solid Fill group, click the orange data 
bar format.

Excel formats the selected range.

	 5.	 Select cells I4:I12.

	 6.	 On the Home tab, in the Styles group, click Conditional Formatting. On the 
menu, point to Icon Sets, and then in the left column of the list of formats, click 
the three traffic lights with black borders.

Excel formats the selected cells.

	 7.	 With the range I4:I12 still selected, on the Home tab, in the Styles group, click 
Conditional Formatting, and then click Manage Rules.

The Conditional Formatting Rules Manager opens.

	 8.	 Click the Icon Set rule, and then click Edit Rule.

The Edit Formatting Rule dialog box opens.
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	 9.	 Click the Reverse Icon Order button.

Excel reconfigures the rules so the red light icon is at the top and the green light 
icon is at the bottom.

	 10.	 In the red light icon’s row, in the Type list, click Number.

	 11.	 In the red light icon’s Value field, type 0.7.

	 12.	 In the yellow light icon’s row, in the Type list, click Number.

	 13.	 In the yellow light icon Value field, type 0.5.

	 14.	 Click OK twice to close the Edit Formatting Rule dialog box and the Conditional 
Formatting Rules Manager.

Excel formats the selected cell range.

	 15.	 Click cell C15.

	 16.	 On the Home tab, in the Styles group, click Conditional Formatting. On the 
menu, point to Highlight Cells Rules, and then click Less Than.

The Less Than dialog box opens.

	 17.	 In the left field, type 96%.

	 18.	 In the With list, click Red text.



	 19.	 Click OK.

The Less Than dialog box closes, and Excel displays the text in cell C15 in red.

CLEAN UP  Save the Dashboard workbook, and then close it.

Adding Images to Worksheets
Establishing a strong corporate identity helps customers remember your organization  
as well as the products and services you offer. Setting aside the obvious need for sound 
management, two important physical attributes of a strong retail business are a well-
conceived shop space and an eye-catching, easy-to-remember logo. After you or your 
graphic artist has created a logo, you should add the logo to all your documents, especially 
any that might be seen by your customers. Not only does the logo mark the documents 
as coming from your company but it also serves as an advertisement, encouraging anyone 
who sees your worksheets to call or visit your company.

One way to add a picture to a worksheet is to display the Insert tab, and then in the 
Illustrations group, click Picture. Clicking Picture displays the Insert Picture dialog box, 
from which you can locate the picture you want to add from your hard disk. When you 
insert a picture, the Picture Tools Format contextual tab appears on the ribbon. You can 

	 Adding Images to Worksheets    113



114    Chapter 4  Changing Workbook Appearance

use the tools on the Format contextual tab to change the picture’s contrast, brightness, 
and other attributes. With the controls in the Picture Styles group, you can place a bor-
der around the picture, change the picture’s shape, or change a picture’s effects (such as 
shadow, reflection, or three-dimensional effects). Other tools, found in the Arrange and 
Size groups, enable you to rotate, reposition, and resize the picture. 

You can also resize a picture by clicking it and then dragging one of the handles that 
appears on the graphic. If you accidentally resize a graphic by dragging a handle, just 
click the Undo button to remove your change. 

Excel 2010 includes a new built-in capability that you can use to remove the background 
of an image you insert into a workbook. To do so, click the image and then, on the Format 
contextual tab of the ribbon, in the Adjust group, click Remove Background. When you do, 
Excel attempts to identify the foreground and background of the image. 



You can drag the handles on the inner square of the background removal tool to change  
how the tool analyzes the image. When you have adjusted the outline to identify 
the elements of the image you want to keep, click the Keep Changes button on the 
Background Removal contextual tab of the ribbon to complete the operation.

If you want to generate a repeating image in the background of a worksheet to form a 
tiled pattern behind your worksheet’s data, you can display the Page Layout tab, and 
then in the Page Setup group, click Background. In the Sheet Background dialog box, 
click the image that you want to serve as the background pattern for your worksheet, 
and click OK.

Tip  To remove a background image from a worksheet, display the Page Layout tab, and then 
in the Page Setup group, click Delete Background.

To achieve a watermark-type effect with words displayed behind the worksheet data, save 
the watermark information as an image, and then use the image as the sheet background; 
you could also insert the image in the header or footer, and then resize or scale it to  
position the watermark information where you want it.

In this exercise, you’ll add an image to an existing worksheet, change its location on 
the worksheet, reduce the size of the image, and then set another image as a repeating 
background for the worksheet.
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SET UP  You need the CallCenter_start workbook and the phone and texture images 
located in your Chapter04 practice file folder to complete this exercise. Open the 
CallCenter_start workbook, and save it as CallCenter. Then follow the steps. 

	 1.	 On the Insert tab, in the Illustrations group, click Picture.

The Insert Picture dialog box opens.

	 2.	 Navigate to the Chapter04 practice file folder, and then double-click the phone 
image file.

The image appears on your worksheet.

	 3.	 On the Format contextual tab, in the Adjust group, click Remove Background.

Excel attempts to separate the image’s foreground from its background.

	 4.	 Drag the handles at the upper-left and bottom-right corners of the outline until 
the entire phone, including the cord, is within the frame.

	 5.	 On the Background Removal tab, click Keep Changes.

Excel removes the highlighted image elements.



	 6.	 Move the image to the upper-left corner of the worksheet, click and hold the handle 
at the lower-right corner of the image, and drag it up and to the left until the image 
no longer obscures the Call Volume label.

	 7.	 On the Page Layout tab, in the Page Setup group, click Background.

The Sheet Background dialog box opens.

	 8.	 Navigate to the Chapter04 practice file folder, and then double-click the texture 
image file.

Excel repeats the image to form a background pattern.
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	 9.	 On the Page Layout tab, in the Page Setup group, click Delete Background.

Excel removes the background image.

CLEAN UP  Save the CallCenter workbook, and then close it. If you are not continuing 
directly to the next chapter, exit Excel.



Key Points
●	 If you don’t like the default font in which Excel displays your data, you can change it.

●	 You can use cell formatting, including borders, alignment, and fill colors, to 
emphasize certain cells in your worksheets. This emphasis is particularly useful 
for making column and row labels stand out from the data.

●	 Excel comes with a number of existing styles that enable you to change the 
appearance of individual cells. You can also create new styles to make format-
ting your workbooks easier.

●	 If you want to apply the formatting from one cell to another cell, use the Format 
Painter to copy the format quickly.

●	 There are quite a few built-in document themes and Excel table formats you can 
apply to groups of cells. If you see one you like, use it and save yourself lots of 
formatting time.

●	 Conditional formats enable you to set rules so that Excel changes the appearance 
of a cell’s contents based on its value.

●	 Adding images can make your worksheets more visually appealing and make your 
data easier to understand. Excel 2010 greatly enhances your ability to manage 
your images without leaving Excel.
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	 9	 Creating Dynamic 
		  Worksheets by Using  
		  PivotTables
In this chapter, you will learn how to
✔	 Analyze data dynamically by using PivotTables.
✔	 Filter, show, and hide PivotTable data.
✔	 Edit PivotTables.
✔	 Format PivotTables.
✔	 Create PivotTables from external data.

When you create Microsoft Excel 2010 worksheets, you must consider how you want the 
data to appear when you show it to your colleagues. You can change the formatting of 
your data to emphasize the contents of specific cells, sort and filter your worksheets based 
on the contents of specific columns, or hide rows containing data that isn’t relevant to the 
point you’re trying to make.

One limitation of the standard Excel worksheet is that you can’t easily change how 
the data is organized on the page. For example, in a worksheet in which each column 
represents an hour in the day, each row represents a day in a month, and the body of 
the worksheet contains the total sales for every hourly period of the month, you can’t 
change the worksheet quickly so that it displays only sales on Tuesdays during the 
afternoon.

There is an Excel tool with which you can create worksheets that can be sorted, filtered, 
and rearranged dynamically to emphasize different aspects of your data. That tool is the 
PivotTable.
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In this chapter, you’ll learn how to create and edit PivotTables from an existing work-
sheet, focus your PivotTable data using filters and Slicers, format PivotTables, and  
create a PivotTable with data imported from a text file.

Practice Files  Before you can complete the exercises in this chapter, you need to copy 
the book’s practice files to your computer. The practice files you’ll use to complete the 
exercises in this chapter are in the Chapter09 practice file folder. A complete list of 
practice files is provided in “Using the Practice Files” at the beginning of this book.

Analyzing Data Dynamically by Using PivotTables
With Excel worksheets you can gather and present important data, but the standard work-
sheet can’t be changed from its original configuration easily. As an example, consider a 
worksheet that records monthly package volumes for each of nine distribution centers in 
the United States. 

Troubleshooting  The appearance of buttons and groups on the ribbon changes depending 
on the width of the program window. For information about changing the appearance of 
the ribbon to match our screen images, see “Modifying the Display of the Ribbon” at the 
beginning of this book.



The data in the worksheet is organized so that each row represents a distribution center 
and each column represents a month of the year. When presented in this arrangement, 
the monthly totals for all centers and the yearly total for each distribution center are 
given equal billing: neither set of totals stands out.

Such a neutral presentation of your data is versatile, but it has limitations. First, although 
you can use sorting and filtering to restrict the rows or columns shown, it’s difficult to 
change the worksheet’s organization. For example, in this worksheet, you can’t easily 
reorganize the contents of your worksheet so that the months are assigned to the rows 
and the distribution centers are assigned to the columns.

The Excel tool to reorganize and redisplay your data dynamically is the PivotTable. You 
can create a PivotTable, or dynamic worksheet, that enables you to reorganize and filter 
your data on the fly. For instance, you can create a PivotTable with the same layout as 
the worksheet described previously, which emphasizes totals by month, and then change 
the PivotTable layout to have the rows represent the months of the year and the columns 
represent the distribution centers. The new layout emphasizes the totals by regional 
distribution center.
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To create a PivotTable, you must have your data collected in a list. Excel tables mesh 
perfectly with PivotTable dynamic views; not only do Excel tables have a well-defined 
column and row structure, but the ability to refer to an Excel table by its name also 
greatly simplifies PivotTable creation and management.

In the Excel table used to create the distribution PivotTable, each row of the table con-
tains a value representing the distribution center, date, month, week, weekday, day, and 
volume for every day of the years 2009 and 2010.

Excel needs that data when it creates the PivotTable so that it can maintain relation-
ships among the data. If you want to filter your PivotTable so that it shows all package 
volumes on Thursdays in January, for example, Excel must be able to identify January 11 
as a Thursday.

After you create an Excel table, you can click any cell in the table, display the Insert tab 
and then, in the Tables group, click PivotTable to open the Create PivotTable dialog box.



In this dialog box, you verify the data source for your PivotTable and whether you want to 
create a PivotTable on a new worksheet or an existing worksheet. After you click OK, Excel 
displays a new or existing worksheet and displays the PivotTable Field List task pane.

Tip  You should always place your PivotTable on its own worksheet to avoid cluttering the 
display.
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If the PivotTable Field List task pane isn’t visible, you can display it by clicking any cell in 
the PivotTable to display the PivotTable Tools contextual tabs. On the Options contextual 
tab, in the Show/Hide group, click Field List.

To assign a field, or column of data, to an area of the PivotTable, drag the field header 
from the Choose Fields To Add To Report area at the top of the PivotTable Field List task 
pane to the Drag Fields Between Areas Below area at the bottom of the task pane. For 
example, if you drag the Volume field header to the Values area, the PivotTable displays 
the total of all entries in the Volume column. 



It’s important to note that the order in which you enter the fields in the Row Labels 
and Column Labels areas affects how Excel organizes the data in your PivotTable. As an 
example, consider a PivotTable that groups the PivotTable rows by distribution center 
and then by month.
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The same PivotTable data could also be organized by month and then by distribution 
center.

In the preceding examples, all the field headers are in the Row Labels area. If you drag 
the Center header from the Row Labels area to the Column Labels area, the PivotTable 
reorganizes (pivots) its data to form a different configuration.



To pivot a PivotTable, you drag a field header to a new position in the PivotTable Field List 
task pane. As you drag a field within the task pane, Excel displays a blue line in the interior 
of the target area so you know where the field will appear when you release the left mouse 
button. If your data set is large or if you based your PivotTable on a data collection on 
another computer, it might take some time for Excel to reorganize the PivotTable after a 
pivot. You can have Excel delay redrawing the PivotTable by selecting the Defer Layout 
Update check box in the lower-left corner of the PivotTable Field List task pane. When 
you’re ready for Excel to display the reorganized PivotTable, click Update.

If you expect your PivotTable source data to change, such as when you link to an external 
database that records shipments or labor hours, you should ensure that your PivotTable 
summarizes all the available data. To do that, you can refresh the PivotTable connection 
to its data source. If Excel detects new data in the source table, it updates the PivotTable 
contents accordingly. To refresh your PivotTable, click any cell in the PivotTable and then, 
on the Options contextual tab, in the Data group, click Refresh.
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In this exercise, you’ll create a PivotTable by using data from a table, add fields to  
the PivotTable, and then pivot the PivotTable.

SET UP  You need the Creating_start workbook located in your Chapter09 practice 
file folder to complete this exercise. Start Excel, open the Creating_start workbook, 
and save it as Creating. Then follow the steps. 

	 1.	 Click any cell in the Excel table.

	 2.	 On the Insert tab, in the Tables group, click the PivotTable button (not the arrow).

The Create PivotTable dialog box opens.

	 3.	 Verify that the DailyVolumes table name appears in the Table/Range field and 
that the New Worksheet option is selected.

	 4.	 Click OK.

Excel creates a PivotTable on a new worksheet.

	 5.	 In the PivotTable Field List task pane, drag the Center field header to the Row 
Labels area.

Excel adds the Center field values to the PivotTable row area.



	 6.	 In the PivotTable Field List task pane, drag the Year field header to the Column 
Labels area.

Excel adds the Year field values to the PivotTable column area.

	 7.	 In the PivotTable Field List task pane, drag the Volume field header to the 
Values area.

Excel fills in the body of the PivotTable with the Volume field values.

	 8.	 In the PivotTable Field List task pane, in the Column Labels area, drag the 
Year field header to the Row Labels area, and drop it beneath the Center field 
header.

Excel changes the PivotTable to reflect the new organization.

CLEAN UP  Save the Creating workbook, and then close it.
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Filtering, Showing, and Hiding PivotTable Data
PivotTables often summarize huge data sets in a relatively small worksheet. The more 
details you can capture and write to a table, the more flexibility you have in analyzing 
the data. As an example, consider all the details captured in a table in which each row 
contains a value representing the distribution center, date, month, week, weekday, day, 
and volume for every day of the year.

Each column, in turn, contains numerous values: there are nine distribution centers, 
data from two years, 12 months in a year, seven weekdays, and as many as five weeks 
and 31 days in a month. Just as you can filter the data that appears in an Excel table 
or other data collection, you can filter the data displayed in a PivotTable by selecting 
which values you want the PivotTable to include.

See Also  For more information on filtering an Excel table, see “Limiting Data That Appears on 
Your Screen” in Chapter 5, “Focusing on Specific Data by Using Filters.”



To filter a PivotTable based on a field’s contents, click the field’s header in the Choose 
Fields To Add To Report area of the PivotTable Field List task pane. When you do, Excel 
displays a menu of sorting and filtering options.

The PivotTable displays several sorting options, commands for different categories of 
filters, and a list of items that appear in the field you want to filter. Every list item has a 
check box next to it. Items with a check mark in the box are currently displayed in the 
PivotTable, and items without a check mark are hidden. 

The first entry at the top of the item list is the Select All check box. The Select All check 
box can have one of three states: displaying a check mark, displaying a black square,  
or empty. If the Select All check box contains a check mark, then the PivotTable dis-
plays every item in the list. If the Select All check box is empty, then no filter items are 
selected. Finally, if the Select All check box contains a black square, it means that some, 
but not all, of the items in the list are displayed. Selecting only the Northwest check box, 
for example, leads to a PivotTable configuration in which only the data for the Northwest 
center is displayed.
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If you’d rather display as much PivotTable data as possible, you can hide the PivotTable 
Field List task pane and filter the PivotTable by using the filter arrows on the Row Labels 
and Column Labels headers within the body of the PivotTable. Clicking either of those 
headers enables you to select a field by which you can filter; you can then define the 
filter by using the same controls you see when you click a field header in the PivotTable 
Field List task pane.

Excel indicates that a PivotTable has filters applied by placing a filter indicator next to the 
Column Labels or Row Labels header, as appropriate, and the filtered field name in 
the PivotTable Field List task pane.



So far, all the fields by which we’ve filtered the PivotTable have changed the organiza-
tion of the data in the PivotTable. Adding some fields to a PivotTable, however, might 
create unwanted complexity. For example, you might want to filter a PivotTable by 
weekday, but adding the Weekday field to the body of the PivotTable expands the 
table unnecessarily.

Instead of adding the Weekday field to the Row Labels or Column Labels area, you can 
drag the field to the Report Filter area near the bottom of the PivotTable Field List task 
pane. Doing so leaves the body of the PivotTable unchanged, but adds a new area above 
the PivotTable in its worksheet.
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Tip  In Excel 2003 and earlier versions, this area was called the Page Field area.

When you click the filter arrow of a field in the Report Filter area, Excel displays a list of 
the values in the field. When you click the filter arrow, you can choose to filter by one 
value at a time. If you’d like to filter your PivotTable by more than one value, you can 
do so by selecting the Select Multiple Items check box.

If your PivotTable has more than one field in the Row Labels area, you can filter values 
in a PivotTable by hiding and collapsing levels of detail within the report. To do that, 
you click the Hide Detail control (which looks like a box with a minus sign in it) or the 
Show Detail control (which looks like a box with a plus sign in it) next to a header.  



For example, you might have your data divided by year; clicking the Show Detail control 
next to the 2009 year header would display that year’s details. Conversely, clicking the 
2010 year header’s Hide Detail control would hide the individual months’ values and 
display only the year’s total.

Excel 2010 provides two new ways for you to filter PivotTables: search filters and Slicers. 
With a search filter, you can type in a series of characters for Excel to filter that field’s 
values. To create a search filter, click a field’s filter arrow and type the character string 
for which you want to search in the filter menu’s Search box.
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For example, if the PivotTable’s Center field contains the values Atlantic, Central, Midwest, 
Mountain West, North Central, Northeast, Northwest, Southeast, and Southwest, typing 
the character string “No” limits the values to North Central, Northeast, and Northwest.

Tip  Search filters look for the character string you specify anywhere within a field’s value, 
not just at the start of the value. In the previous example, the search filter string “cen” would 
return both Central and North Central.

In versions of Excel prior to Excel 2010, the only visual indication that you had applied a 
filter to a field was the indicator added to a field’s filter arrow. The indicator told users  
that there was an active filter applied to that field but provided no information on 
which values were displayed and which were hidden. In Excel 2010, Slicers provide a 
visual indication of which items are currently displayed or hidden in a PivotTable. 



To create a Slicer, click any cell in a PivotTable and then, on the Options contextual tab 
of the ribbon, in the Sort & Filter group, click Insert Slicer to display the Insert Slicers 
dialog box.

Select the check box next to the fields for which you want to create a Slicer, and click OK. 
When you do, Excel 2010 displays a Slicer for each field you identified.
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Tip  If you have already applied a filter to the field for which you display a Slicer, the Slicer 
reflects the filter’s result.

A Slicer displays the values within the PivotTable field you identified. Any value displayed in 
color (or gray if you select a gray-and-white color scheme) appears within the PivotTable. 
Values displayed in light gray or white do not appear in the PivotTable. 

Clicking an item in a Slicer changes that item’s state—if a value is currently displayed in 
a PivotTable, clicking it hides it. If it’s hidden, clicking its value in the Slicer displays it 
in the PivotTable. As with other objects in an Excel 2010 workbook, you can use the Shift 
and Ctrl keys to help define your selections. For example, suppose you create a Slicer for 
the Month field while every month is displayed.



If you want to hide every month except January, February, and March, you click the 
January item to hide every month except January. Then hold down the Shift key 
and click March to have Excel 2010 display just the data for the months of January, 
February, and March. You can then add another month, such as July, to the filter by 
holding down the Ctrl key and clicking July in the Slicer.
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To use a Slicer to remove a filter, click the Clear Filter button in the upper-right corner of 
the Slicer. If you want to resize a Slicer, you can do so by dragging the resize handle in the 
lower-right corner of the Slicer. To hide the Slicer, right-click it and then click the menu 
command that starts with the word “Remove.” For example, the Month field’s menu com-
mand would be Remove Month.

Tip  You can change a Slicer’s formatting by clicking the Slicer and then, on the Slicer Tools 
Options contextual tab on the ribbon, clicking a style in the Slicer Styles gallery.

In this exercise, you’ll focus the data displayed in a PivotTable by creating a filter, by filter-
ing a PivotTable based on the contents of a field in the Report Filters area, by showing and 
hiding levels of detail within the body of the PivotTable, by using the Search box, and by 
using Slicers.

SET UP  You need the Focusing_start workbook located in your Chapter09 practice 
file folder to complete this exercise. Open the Focusing_start workbook, and save it 
as Focusing. Then follow the steps. 

	 1.	 On the Sheet2 worksheet, click any cell in the PivotTable.

	 2.	 In the PivotTable Field List task pane’s Choose fields to add to report area, 
click the Center field header, click the Center field filter arrow, and then clear the 
(Select All) check box.



Excel clears all the check boxes in the filter menu.

	 3.	 Select the Northwest check box, and then click OK.

Excel filters the PivotTable.

	 4.	 On the Quick Access Toolbar, click the Undo button.

Excel removes the filter.

	 5.	 In the PivotTable Field List task pane, drag the Weekday field header from the 
Choose fields to add to report area to the Report Filter area in the Drag fields 
between areas below area.

	 6.	 In the PivotTable Field List task pane, click the Close button.

The PivotTable Field List task pane closes.

	 7.	 In the body of the worksheet, click the Weekday filter arrow, and then, if necessary, 
select the Select Multiple Items check box.

Excel adds check boxes beside the items in the Weekday field filter list.

	 8.	 Clear the All check box.

Excel clears each check box in the list.
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	 9.	 Select the Tuesday and Thursday check boxes, and then click OK.

Excel filters the PivotTable, summarizing only those values from Tuesdays and 
Thursdays.

	 10.	 In cell A5, click the Hide Detail button.

Excel collapses rows that contain data from the year 2009, leaving only the subtotal 
row that summarizes that year’s data.

	 11.	 In cell A5, click  the Show Detail button.

Excel redisplays the collapsed rows.

	 12.	 On the ribbon, click the Options contextual tab, and then, in the Show group, click 
Field List.

The PivotTable Field List task pane opens.

	 13.	 In the PivotTable Field List task pane, click the Month field header arrow.

The filter menu opens.



	 14.	 In the Search box, type Ju.

Excel displays the months June and July in the filter list.

	 15.	 Click OK.

Excel applies the filter.

	 16.	 On the Options contextual tab of the ribbon, in the Actions group, click the Clear 
button, and then click Clear Filters.

Excel clears all filters from the PivotTable.

	 17.	 On the Options contextual tab of the ribbon, in the Sort & Filter group, click 
Insert Slicer.

The Insert Slicers dialog box opens.

	 18.	 In the Insert Slicers dialog box, select the Center check box, and then click OK.

A Slicer for the Center field appears.

	 19.	 Click the Atlantic item.

Excel filters the PivotTable so only results for the Atlantic center appear.
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	 20.	 In the Slicer, click Midwest, and then, while holding down the Ctrl key, click 
Mountain West and then Northwest.

Excel filters the PivotTable so it displays results for the Midwest, Mountain West, 
and Northwest centers.

	 21.	 In the upper-right corner of the Slicer, click the Clear Filter button.

Excel removes the filter from the Center field.

	 22.	 Right-click the Slicer, and then click Remove "Center".

Excel closes the Slicer.

CLEAN UP  Save the Focusing workbook, and then close it.

Editing PivotTables
After you create a PivotTable, you can rename it, edit it to control how it summarizes your 
data, and use the PivotTable cell data in a formula. As an example, consider a PivotTable 
named PivotTable2 that summarizes package volumes for every Consolidated Messengers 
regional distribution hub.



Excel displays the PivotTable name on the Options contextual tab, in the PivotTable 
Options group. The name PivotTable2 doesn’t help you or your colleagues understand 
the data the PivotTable contains, particularly if you use the PivotTable data in a formula 
on another worksheet. To give your PivotTable a more descriptive name, click any cell in 
the PivotTable and then, on the Options contextual tab, in the PivotTable Options group, 
type the new name in the PivotTable Name field.

When you create a PivotTable with at least one field in the Row Labels area and one field 
in the Column Labels area of the PivotTable Field List task pane, Excel adds a grand total 
row and column to summarize your data. You can control how and where these sum-
mary rows and columns appear by clicking any PivotTable cell and then, on the Design 
contextual tab, in the Layout group, clicking either the Subtotals or Grand Totals button 
and selecting the desired layout.

After you create a PivotTable, Excel determines the best way to summarize the data in the 
column you assign to the Values area. For numeric data, for example, Excel uses the SUM 
function. If you want to change a PivotTable summary function, right-click any data cell in 
the PivotTable values area, point to Summarize Values By, and then click the desired opera-
tion. If you want to use a function other than those listed, click More Options to display the 
Value Field Settings dialog box. On the Summarize Values By page of the dialog box, you 
can choose the summary operation you want to use.
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You can also change how the PivotTable displays the data in the Values area. On the Show 
Values As page of the Value Field Settings dialog box, you can select whether to display 
each cell’s percentage contribution to its column’s total, its row’s total, or its contribution 
to the total of all values displayed in the PivotTable.

If you want, you can create a formula that incorporates a value from a PivotTable cell. 
To do so, you click the cell where you want to create the formula, type an equal sign, 
and then click the cell in the PivotTable that contains the data you want to appear in the 
other cell. A GETPIVOTDATA formula appears in the formula box of the worksheet that 
contains the PivotTable. When you press Enter, Excel creates the GETPIVOTDATA formula 
and displays the contents of the PivotTable cell in the target cell.



In this exercise, you’ll rename a PivotTable, specify whether subtotal and grand total rows 
will appear, change the PivotTable summary function, display each cell’s contribution to 
its row’s total, and create a formula that incorporates a value in a PivotTable cell.

SET UP  You need the Editing_start workbook located in your Chapter09 practice 
file folder to complete this exercise. Open the Editing_start workbook, and save it 
as Editing. Then follow the steps.

	 1.	 On the PivotTable worksheet, click any cell in the PivotTable.

	 2.	 On the Options contextual tab, in the PivotTable group, in the PivotTable Name 
field, type VolumeSummary and press Enter.

Excel renames the PivotTable.

	 3.	 On the Design contextual tab, in the Layout group, click Subtotals, and then click 
Do Not Show Subtotals.

Excel removes the subtotal rows from the PivotTable.

	 4.	 On the Design contextual tab, in the Layout group, click Grand Totals, and then 
click On for columns only.

Excel removes the cells that calculate each row’s grand total.
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	 5.	 On the Quick Access Toolbar, click the Undo button.

Excel reverses the last change.

	 6.	 Right-click any data cell in the PivotTable, point to Summarize Values By, and then 
click Average.

Excel changes the Value field summary operation.

	 7.	 On the Quick Access Toolbar, click the Undo button.

Excel reverses the last change.

	 8.	 Right-click any data cell in the PivotTable, and then click Value Field Settings.

The Value Field Settings dialog box opens.

	 9.	 Click the Show Values As tab.

The Show Values As page appears.

	 10.	 In the Show Values As list, click % of Row Total.

	 11.	 Click OK.

Excel changes how it calculates the values in the PivotTable.



	 12.	 On the Quick Access Toolbar, click the Undo button.

Excel reverses the last change.

	 13.	 On the Design tab, in the Layout group, click Subtotals, and then click Show All 
Subtotals at Bottom of Group.

Excel displays subtotals in the workbook.

	 14.	 Click the Package Summary sheet tab.

The Package Summary worksheet appears.

	 15.	 In cell C4, type =, but do not press Enter.

	 16.	 Click the PivotTable sheet tab.

The PivotTable worksheet appears.

	 17.	 Click cell K32, and then press Enter.

Excel creates the formula =GETPIVOTDATA(“Volume”,PivotTable!$A$3,”Year”,2010) 
in cell C4.
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CLEAN UP  Save the Focusing workbook, and then close it.

Formatting PivotTables
PivotTables are the ideal tools for summarizing and examining large data tables, even 
those containing more than 10,000 or even 100,000 rows. Even though PivotTables often 
end up as compact summaries, you should do everything you can to make your data more 
comprehensible. One way to improve your data’s readability is to apply a number format 
to the PivotTable Values field. To apply a number format to a field, right-click any cell in the 
field, and then click Number Format to display the Format Cells dialog box. Select or define 
the format you want to apply, and then click OK to enact the change.

See Also  For more information on selecting and defining cell formats by using the Format 
Cells dialog box, see “Formatting Cells” in Chapter 4, “Changing Workbook Appearance.”

Analysts often use PivotTables to summarize and examine organizational data with an 
eye to making important decisions about the company. For example, chief operating 
officer Lori Penor might examine monthly package volumes handled by Consolidated 
Messenger and notice that there’s a surge in package volume during the winter months 
in the United States.



Excel extends the capabilities of your PivotTables by enabling you to apply a conditional 
format to the PivotTable cells. What’s more, you can select whether to apply the condi-
tional format to every cell in the Values area, to every cell at the same level as the selected 
cell (that is, a regular data cell, a subtotal cell, or a grand total cell) or to every cell that 
contains or draws its values from the selected cell’s field (such as the Volume field in the 
previous example).

To apply a conditional format to a PivotTable field, click a cell in the Values area. On the 
Home tab, in the Styles group, click Conditional Formatting, and then create the desired 
conditional format. After you do, Excel displays a Formatting Options action button, 
which offers three options for applying the conditional format:

●	 Selected Cells  Applies the conditional format to the selected cells only

●	 All Cells Showing Sum of field_name Values  Applies the conditional format to every 
cell in the data area, regardless of whether the cell is in the data area, a subtotal row 
or column, or a grand total row or column

●	 All Cells Showing Sum of field_name Values for Fields  Applies the conditional 
format to every cell at the same level (for example, data cell, subtotal, or grand 
total) as the selected cells
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See Also  For more information on creating conditional formats, see “Changing the 
Appearance of Data Based on Its Value” in Chapter 4, “Changing Workbook Appearance.”

In Excel, you can take full advantage of the Microsoft Office system enhanced formatting 
capabilities to apply existing formats to your PivotTables. Just as you can create Excel 
table formats, you can also create your own PivotTable formats to match your organi-
zation’s desired color scheme.

To apply a PivotTable style, click any cell in the PivotTable and then, on the Design con-
textual tab, in the PivotTable Styles group, click the gallery item representing the style 
you want to apply. If you want to create your own PivotTable style, click the More button 
in the PivotTable Styles gallery (in the lower-right corner of the gallery), and then click 
New PivotTable Style to display the New PivotTable Quick Style dialog box.

Type a name for the style in the Name field, click the first table element you want to cus-
tomize, and then click Format. Use the controls in the Format Cells dialog box to change 
the element’s appearance. After you click OK to close the Format Cells dialog box, the New 
PivotTable Quick Style dialog box Preview pane displays the style’s appearance. If you want 
Excel to use the style by default, select the Set As Default PivotTable Quick Style For This 
Document check box. After you finish creating your formats, click OK to close the New 
PivotTable Quick Style dialog box and save your style.



The Design contextual tab contains many other tools you can use to format your PivotTable, 
but one of the most useful is the Banded Columns check box, which you can find in the 
PivotTable Style Options group. If you select a PivotTable style that offers banded rows as 
an option, selecting the Banded Rows check box turns banding on. If you prefer not to have 
Excel band the rows in your PivotTable, clearing the check box turns banding off.

In this exercise, you’ll apply a number format to a PivotTable values field, apply a PivotTable 
style, create your own PivotTable style, give your PivotTable banded rows, and apply a con-
ditional format to a PivotTable.

SET UP  You need the Formatting_start workbook located in your Chapter09 practice 
file folder to complete this exercise. Open the Formatting_start workbook, and save it 
as Formatting. Then follow the steps. 

	 1.	 On the Sheet2 worksheet, right-click any data cell, and then click Number Format.

The Format Cells dialog box opens.

	 2.	 In the Category list, click Number.

The Number page is displayed.
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	 3.	 In the Decimal places field, type 0.

	 4.	 Select the Use 1000 Separator (,) check box.

	 5.	 Click OK.

Excel reformats your PivotTable data.

	 6.	 If necessary, on the Design contextual tab, in the PivotTable Style Options group, 
select the Banded Rows check box.

	 7.	 On the Design contextual tab, in the PivotTable Styles group, click the More 
button. Then, in the top row of the gallery, click the third style from the left. 
(When you point to it, Excel displays a ScreenTip that reads Pivot Style Light 2.)



Excel applies the PivotTable style.

	 8.	 In the lower-right corner of the PivotTable Styles gallery, click the More button.

The gallery expands.

	 9.	 Click New PivotTable Style.

The New PivotTable Quick Style dialog box opens.
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	 10.	 In the Name field, type Custom Style 1.

	 11.	 In the Table Element list, click Header Row, and then click Format.

The Format Cells dialog box opens.

	 12.	 On the Font page, in the Color list, click the white square.

	 13.	 On the Border page, in the Presets area, click Outline.

	 14.	 On the Fill page, in the Background Color area, click the purple square at the 
lower-right corner of the color palette.

	 15.	 Click OK.

The Format Cells dialog box closes, and the style change appears in the Preview 
pane of the New PivotTable Quick Style dialog box.

	 16.	 In the Table Element list, click Second Row Stripe, and then click Format.

The Format Cells dialog box opens.

	 17.	 On the Fill page, in the middle part of the Background Color area, click the 
eighth square in the second row (it’s a light, dusty purple).

	 18.	 Click OK twice.



The Format Cells dialog box closes, and your format appears in the PivotTable 
Styles gallery.

	 19.	 Click the new style.

Excel formats your PivotTable using your custom PivotTable style.

	 20.	 On the Design contextual tab, in the PivotTable Style Options group, clear the 
Banded Rows check box.

Excel removes the banding from your PivotTable and from the preview of the 
custom style.
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	 21.	 Select the cell ranges K6:K17 and K19:K30.

	 22.	 On the Home tab, in the Styles group, click Conditional Formatting, point to 
Color Scales, and in the top row, click the second three-color scale from the left.

Excel applies the conditional format to the selected cells.

CLEAN UP  Save the Formatting workbook, and then close it.

Creating PivotTables from External Data
Although most of the time you will create PivotTables from data stored in Excel worksheets, 
you can also bring data from outside sources into Excel. For example, you might need 
to work with data created in another spreadsheet program with a file format that Excel 
can’t read directly. Fortunately, you can export the data from the original program into a 
text file, which Excel then translates into a worksheet.



Tip  The data import technique shown here isn’t exclusive to PivotTables. You can use this 
procedure to bring data into your worksheets for any purpose.

Spreadsheet programs store data in cells, so the goal of representing spreadsheet data in 
a text file is to indicate where the contents of one cell end and those of the next cell begin. 
The character that marks the end of a cell is a delimiter, in that it marks the end (or “limit”) 
of a cell. The most common cell delimiter is the comma, so the delimited sequence 15, 18, 
24, 28 represents data in four cells. The problem with using commas to delimit financial 
data is that larger values—such as 52,802—can be written by using commas as thousands 
markers. To avoid confusion when importing a text file, the most commonly used delimiter 
for financial data is the Tab character.

To import data from a text file, on the Data tab, in the Get External Data group, click 
From Text to display the Import Text File dialog box.
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From within the Import Text File dialog box, browse to the directory that contains  
the text file you want to import. Double-clicking the file launches the Text Import 
wizard.

On the first page of the Text Import wizard, you can indicate whether the data file you 
are importing is Delimited or Fixed Width; Fixed Width means that each cell value will fall 
within a specific position in the file. Clicking Next to accept the default choice, Delimited 
(which Excel assigns after examining the data source you selected), advances you to the 
next wizard page.



On this page, you can choose the delimiter for the file (in this case, Excel detected tabs in 
the file and selected the Tab check box for you) and gives you a preview of what the text 
file will look like when imported. Clicking Next advances you to the final wizard page.
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On this page, you can change the data type and formatting of the columns in your data. 
Because you’ll assign number styles and PivotTable Quick Styles after you create the 
PivotTable, you can click Finish to import the data into your worksheet. After the data is 
in Excel, you can work with it normally.

In this exercise, you’ll import data into Excel from a text file and then create a PivotTable 
based on that data.

SET UP  You need the Creating_start text file located in your Chapter09 practice file 
folder to complete this exercise. 

	 1.	 Create a new Excel workbook. On the Data tab, click the Get External Data button, 
and then click From Text.

The Import Text File dialog box opens.

	 2.	 Navigate to the Chapter09 practice file folder, and then double-click 
Creating_start.txt.

The Text Import wizard starts.

	 3.	 Verify that the Delimited option is selected, and then click Next.

The next Text Import Wizard page opens.

	 4.	 In the Delimiters area, verify that the Tab check box is selected and also verify 
that the data displayed in the Data preview area reflects the structure you 
expect.

	 5.	 Click Finish.

Clicking Finish skips page 3 of the wizard, which has commands you can use 
to assign specific data types to each column. Excel assigns data types for you, 
so you don’t need to do so. After you click Finish, the Import Data dialog box 
opens.



	 6.	 Verify that the Existing worksheet option is selected, and then click OK.

Excel imports the data into your workbook.

	 7.	 On the Home tab, in the Styles group, click Format as Table, and then click the 
first table style.

The Format As Table dialog box opens.

	 8.	 Verify that the My table has headers check box is selected and that the range 
=$A$1:$H$6571 appears in the Where is the data for your table? box, and 
then click OK.

A confirmation dialog box opens.

	 9.	 Click Yes to confirm you want to create the Excel table and break its link to the 
external data source.

Excel creates an Excel table from your imported data.

	 10.	 On the Insert tab, in the Tables group, click PivotTable.

The Create PivotTable dialog box opens.

	 11.	 Verify that the Select a table or range option is selected, that Table1 appears in 
the Table/Range field, and that the New Worksheet option is selected.

	 12.	 Click OK.

Excel creates the PivotTable on a new worksheet.

	 13.	 In the PivotTable Field List task pane, drag the Volume field header to the 
Values area.

	 14.	 Drag the Weekday field header to the Column Labels area.

	 15.	 Drag the Center field header to the Row Labels data area.
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	 16.	 On the Quick Access Toolbar, click the Save button.

The Save As dialog box opens.

	 17.	 Browse to the Chapter09 folder.

	 18.	 In the File name field, type ImportedData.

	 19.	 Click Save.

Excel saves your file.

CLEAN UP  Close the Imported Data workbook. If you’re not continuing directly to 
the next chapter, exit Excel.



Key Points
●	 A PivotTable is a versatile tool you can use to rearrange your data dynamically, 

enabling you to emphasize different aspects of your data without creating new 
worksheets.

●	 PivotTable data must be formatted as a list. By using a data table as the PivotTable 
data source, you can streamline the creation process by referring to the table name 
instead of being required to select the entire range that contains  
the data you want to summarize.

●	 Excel comes with many attractive styles for PivotTables; you’ll probably find one 
you like.

●	 With the PivotTable Field List task pane, you can create your PivotTable by using 
a straightforward, compact tool.

●	 Just as you can limit the data shown in a static worksheet, you can use filters to 
limit the data shown in a PivotTable.

●	 Excel 2010 includes two new types of filters, search filters and Slicers, that you can 
use to limit the data in your PivotTables.

●	 If you have data in a compatible format, such as a text file, you can import that 
data into Excel and create a PivotTable from it.
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Symbols and 
Numbers
$ (dollar sign)

in absolute references, 68
in link references, 176

= (equal sign)
in formulas, 60
in link references, 176, 177

##### error code,� 75
! (exclamation point), in references,� 176
[ ] (square brackets)

in formulas, 63, 73
in references, 176

3-D appearance, SmartArt graphic, changing,� 290
3-D references,� 176,� 393
64-bit version of Excel 2010, xxii

A
absolute references,� 81

changing to relative references, 68
defined, 393
dollar sign ($) in, 68

Accept Or Reject Changes dialog box,� 376,� 378
accepting changes,� 376,� 378
actions, recording in macros.� See macros
active cells

in cell group, 35
defined, 34, 393
in filtering, 122

Add Constraint dialog box,� 202,� 204
Add Scenario dialog box,� 191,� 192
Add Shape button (SmartArt),� 289,� 290
adding borders 

to cells, 86, 88
to images, 114

adding cells to formulas,� 64
adding comments,� 373,� 374
adding headers and footers,� 306
adding data to Excel tables,� 49,� 51
adding digital signatures,� 386,� 387
adding equations to shapes,� 296,� 299
adding formulas to Excel tables,� 67
adding functions to formulas,� 60
adding images to worksheets,� 113,� 116

adding macros to Quick Access Toolbar,� 339
adding shapes to worksheets,� 294,� 297
adding sort levels,� 146,� 148
adding styles to Cell Styles gallery,� 91
adding subtotals to worksheets,� 158
adding text to shapes,� 295,� 298
adding values together,� 60.� See also SUM function
Add-Ins,� 393.� See also Analysis ToolPak, Solver
Add-Ins dialog box,� 201,� 207
Advanced Filter dialog box,� 132,� 133
AGGREGATE function,� 133

compared to SUBTOTAL, 131
function_num argument in, 131
ignoring in AGGREGATE function, 132
ignoring errors in, 132
ignoring hidden rows in, 132
ignoring SUBTOTAL function in, 132
introduced, 131
operations, summarized, 131
options argument in, 132
syntax, 131

Align button (shapes),� 295,� 298
aligning shapes,� 295,� 298
aligning text in shapes,� 298
alignment

cell, changing, 92
shapes, 295

Allow Users To Edit Ranges button,� 381,� 384
Allow Users To Edit Ranges dialog box,� 381,� 382,� 384
alternative data sets.� See scenarios
Analysis group, installing,� 201,� 207
Analysis ToolPak

generating summary statistics with, 209
input range, 208
installing, 207
selecting type of data to analyze, 208

Analyze contextual tab (PivotChart), refreshing 
data from,� 281,� 285

analyzing data.� See data analysis
And option, in filters,� 127
annotations, finding and removing with 

Document Inspector,� 385
applying table styles,� 97
applying themes,� 94
arguments,� 70.� See also specific functions

defined, 62, 393
error codes for, 75, 161

Arrange All button,� 17,� 25

Index
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Arrange Windows dialog box,� 17,� 25
arranging workbook windows,� 17
arrows

on buttons, 85
filter, 122, 124, 125
filter, in PivotTables, 224
filter, in Report Filter area, 226
tracer, 75, 76, 78-79

aspect ratio, defined,� 393
Assign Macro dialog box,� 341,� 343

macro name in, importance of not changing, 341
assigning fields to PivotTables,� 216
Attach button (Outlook 2010), sharing workbooks 

with,� 370
attachments, e-mail, sending workbooks as,� 370,� 371
auditing

changes. See change tracking
errors, 74, 393

authenticating workbooks.� See digital signatures
AutoCalculate,� 129,� 133
AutoComplete,� 31,� 393
AutoCorrect Options action button,� 49
AutoExpansion, Excel table,� 49
AutoFill,� 30-31,� 393
AutoFill Options button,� 32,� 34
AutoFilter,� 122,� 393
automating tasks.� See macros
Auto_Open macro,� 344-346
AutoRepublish

defined, 393
updating Web pages with, 389, 391

AVERAGE function,� 61
and filters, 129
and hidden rows, 129
limitations of, 129

AVERAGEIF function,� 71,� 72,� 74
AVERAGEIFS function,� 71,� 73
averages

functions for calculating, 71
viewing with AutoCalculate, 129, 133

axes, chart.� See charts
Axis Labels dialog box,� 262,� 265

B
Back button (Help), xxxix
backgrounds

deleting images from, 115, 118
of images, removing, xxi, 114, 116
patterns, creating, 115, 117
watermarks, 115

Backstage view
defined, 393
managing workbooks in, ix

Backstage view (Info page)
adding digital certificates from, 386, 387
Document Inspector on, 385
finalizing workbooks from, 385
password entry on, 379
restoring functionality to finalized workbooks 

from, 385
setting passwords from, 379, 382

Backstage view (Print page)
Margins button, 310, 318
navigating, 312
Orientation button, 316
previewing workbooks in, 309, 312, 316
Print Selected Chart button, 326
Print What button, 320
printing commands in, 309, 318
Scaling button, 312, 317
scroll bar, 312
selecting print pages in, 322
Settings area, 322
Show Margins button, 310

Backstage view (Save & Send page)
publishing workbooks to Web from, 389
saving read-only PDF or XPS files from, 372
saving workbooks as Web pages from, 388, 389
sharing workbooks via e-mail from, 371

balloons.� See ScreenTips
banded columns or rows, PivotTable style,� 245,� 246
bar charts.� See charts
Bing search engine,� 44
Bold button,� 85,� 87
boldfacing,� 85,� 87
book features and conventions, xxxi
borders

adding to cells, 86, 88
adding to images, 114
SmartArt graphic, changing, 290

Breaks button,� 313,� 317
breaks, page.� See page breaks
Bring Forward button (shapes),� 296
broken links.� See linking; file linking
Browse dialog box (file embedding),� 356,� 357
Browse dialog box (file linking),� 351,� 352
browsers, defined,� 393
business cases, analyzing.� See data analysis
business planning

Goal Seek and, 198
Solver and, 201

buttons
adding to Quick Access Toolbar, 18, 25
arrows on, 85
custom, (shapes) running macros from, 341, 344
macro, adding to Quick Access Toolbar, 340-342
on Quick Access Toolbar, changing, 341, 343
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C
Calculate Now button,� 61
calculations.� See also formulas; subtotals

and data changes. See scenarios
ignoring values in, 131

capitalization
searching for, 40
sorting and, 147

cascading workbook windows,� 17,� 25
cell groups, active cells in,� 35
cells

absolute references. See absolute references
active. See active cells
adding comments to. See comments
adding hyperlinks to, 358
adding to formulas, 64
alignment, changing, 92
borders, 86, 88
color. See fill color
comments in. See comments
copying, 32, 35
defined, 393
defining alternative values for, 191, 192
deleting, 12, 14
deleting contents of, 85
deleting formatting of, 85
delimiters, 251
entering data into, 30
fill color. See fill color
filling with data series, 30, 32
filtering. See filters
finding sum of, 60
flags in. See comments
formatting. See formatting
hiding formulas in, 381, 383
hyperlink references in, changing, 360
inserting, 12, 14
linked, updating, 177
linking. See linking
locked. See locked cells
maximum number in scenarios, 195
monitoring values in, 77, 78
moving, 12, 14
moving to, 34
noncontiguous, selecting for printing, 322, 325
number formatting in, 93
pasting formulas in, 65
pointing to. See references
printing, 322
ranges. See ranges
references. See references
in scenario summaries, displaying, 194
selected, printing, 322
selecting, 34

selecting with macros, 333
setting validation rules for, 136
shading. See fill color
Solver objective, setting, 202, 203
Solver variable, setting, 202, 204
sorting. See sorting
sparklines in. See sparklines
testing values in. See conditional formatting
visible, summarizing, 129, 131

Cell Styles gallery,� 90,� 91
centering print areas,� 322
centering shapes.� See shapes, aligning
Change Chart Type button (charts),� 269,� 273
Change Chart Type button (PivotCharts),� 282,� 285
Change Chart Type dialog box (charts),� 269,� 273
Change Chart Type dialog box (PivotCharts),� 282,� 285
change tracking,� 375-378

accepting (finalizing) changes, 376, 378
appearance of tracked changes, 375, 376
dates of changes, viewing, 376
distinguishing different users’, 376
histories, creating, 376
histories, settings for, 369
identifying authors, 376
identifying editors, 373
information retention policies and, 369
rejecting changes, 376
removing changes, 376
reviewing changes, 376, 378
ScreenTips, 376
tracking all changes, 376, 377
turning on, 375, 377

changes
accepting (finalizing), 376, 378
auditing. See change tracking
authors, identifying, 373
keeping history of, 369, 376, 378
reconciling conflicts, in shared workbooks, 369
redoing, 44
rejecting, 376
removing, 376
reviewing, 376, 378
tracking. See change tracking
undoing, 44

changing color of worksheet tabs,� 8,� 9
changing conditional formatting rules,� 107,� 111
changing embedded files,� 355,� 356
changing error settings,� 76
changing filter criteria,� 123
changing font size,� 87
changing formatting with macros,� 333
changing linked files,� 352
changing order of conditional formatting rules,� 107
changing order of worksheets,� 8,� 9
changing position of images,� 114
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changing range definitions,� 58
changing reference type,� 68
changing shape of images,� 114
changing sort order,� 150
changing themes,� 96,� 100

effect of, 82
character strings, in search filters,� 228
chart elements,� 267-268,� 271
Chart Elements button,� 268
charts

2D-bar, creating, 264
adding gridlines to, 268
appearance, and themes, 261
axes, changing data on, 261, 265
axes, formatting, 271
axis labels, 267
bar, creating, 264
categories, changing, 262, 265
column headers, omitting from data selection, 262
creating, 260, 264
customizing appearance of, 267, 270
customizing data plotting, 261, 265
customizing elements of, 267, 271
data points, changing formatting, 268
data series, changing formatting, 268
default type, creating, 261
defined, 259, 393
elements of. See chart elements
embedded, printing problems with, 326
formatting, 267, 270
gridlines, 267
height, changing, 263
horizontal axis (x-axis), changing data on, 262, 265
incorrect plotting, reasons for, 261
layout, changing, 270
legends, changing, 262, 265. 267
moving, 263, 264, 266
numbers in, formatting, 271
page headers and footers and, 305
pasting into other Office documents, 364
printing, 326
printing problems with Print What button, 326
resizing, 263
sparklines. See sparklines
style, changing, 267, 270
templates, 269, 272
types, 260
vertical axis (y-axis), changing data on, 262, 265
width, changing, 263
and workbook themes, 267

chart sheets, inserting,� 170
Chart Styles gallery,� 267,� 270
checking spelling,� 43,� 46
Choose A SmartArt Graphic dialog box,� 286,� 290
circles, drawing,� 297

Clear button,� 85
clearing filters,� 124,� 126,� 127
clearing table styles,� 97
clearing validation rules,� 137
closing comments,� 373
code

HTML, in Web pages, 388
macro, viewing, 332, 334

collaboration.� See sharing workbooks
Collapse Dialog button,� 182
collating printed copies,� 318
color

in change tracking, 376
conditional formatting and. See data bars; 

color scales
filling cells with. See fill color
of hyperlinks, 358
sorting by, 146
and themes, 95
worksheet tabs, changing, 8, 9

color scales,� 109,� 110
Colors dialog box,� 95
Column button (sparklines),� 278,� 279
Column Labels area.� See PivotTables
Column Labels header.� See PivotTables
columns, Excel table

adding and removing, 50
references to, 177

columns, PivotTable.� See PivotTable fields
columns, worksheet

##### error code, 75
changing multiple, 11
changing width, 11
copying, 35
defined, 393
deleting, 12
filtering. See filters
formatting, 86
formatting, and importing, 254
headers. See headers, column and row
hidden, removing with Document Inspector, 385
hiding, 12, 13
hiding labels, 23
inserting, 11, 13
labels. See labels, row and column
moving, 35
multiple, sorting by, 146, 148
repeating in printouts, 323, 324
selecting, 35
sorting on, 144
subtotals and, 153
unhiding, 12
width errors, 75

comma, as delimiter,� 251
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commands, adding to Quick Access Toolbar.� See 
buttons, adding to Quick Access Toolbar

comments,� 372-374
adding, 373, 374
appearance of, 372, 373, 374
authors, identifying, 373
closing, 373, 374
deleting, 373, 375
displaying, 373-374
editing, 373
flags indicating, 372
hiding, 373, 374
keeping open, 373, 374
moving through, 374
pointing to, 373
in ranges, 56
removing with Document Inspector, 385
username in, 372, 373

comparing values 
by using color scales, 109, 110
by using data bars, 111
by using icon sets, 111

comparison operations, in Solver problems,  
203,� 205

Compatibility Functions, xiv
conditional formatting

color scales, 109, 110
creating, 106
data bars, xviii, 108, 111
defined, 106, 393
Excel 2010 improvements, xx
icon sets, xix, 109, 111
PivotTables and, 243, 250
referencing other worksheets, xx
rules, 107, 111-112
summary formulas and, 110

Conditional Formatting button,� 107
and PivotTables, 243, 250

Conditional Formatting Rules Manager,� 107,  
109,� 111

conditional formulas,� 70,� 393.�
conditional functions, summarized,� 71
conditions, setting.� See validation rules
Confirm Password dialog box,� 379,� 382,� 383,� 384
Consolidate dialog box,� 181,� 182
consolidating data.� See data consolidation
constraints, in Solver problems,� 202-203,� 204
Convert To Range button (Excel tables),� 369
converting Excel tables to ranges,� 51,� 369
Copy button,� 37,� 134
copying and pasting data, limitations of,� 175
copying and pasting formulas,� 65,� 68
copying cells,� 32,� 35
copying data,� 37

copying formatting,� 32,� 34
copying ranges,� 35
copying worksheet columns,� 35
copying worksheet rows,� 35
copying worksheets,� 7,� 9

effect on Office Themes, 8
COUNT function,� 61,� 71
COUNTA function,� 71
COUNTBLANK function,� 71
COUNTIF function,� 71
COUNTIFS function,� 71,� 73
counting entries,� 61
counts, viewing with AutoCalculate,� 129,� 133
Create button,� 2
Create Charts dialog box, templates in,� 269
Create Digital Certificate dialog box (Office 2010),� 

386,� 387
Create Names From Selection dialog box,� 57
Create PivotTable dialog box,� 214,� 220

and imported data, 255
Create PivotTable With PivotChart dialog box,� 283
Create Sparklines dialog box,� 277,� 279
creating charts,� 260,� 264
creating custom sorts,� 146,� 148
creating custom sort lists,� 147,� 150
creating digital signatures,� 386,� 387
creating Excel tables,� 49,� 51
creating file links,� 350,� 352
creating filters,� 122,� 127
creating formulas,� 60,� 69
creating hyperlinks,� 358,� 359,� 361
creating macros.� See macros, recording
creating passwords,� 380
creating PivotCharts,� 281
creating PivotTables,� 214,� 220
creating ranges,� 56,� 58-59
creating scenarios,� 190,� 192
creating scenario summaries,� 194,� 197
creating search filters,� 227
creating secure workbooks for electronic 

distribution,� 372
creating shapes,� 294
creating Slicers,� 229,� 235
creating styles,� 90,� 91
creating table styles,� 96,� 97
creating themes,� 96
creating workbook templates,� 169,� 171
creating workbooks,� 2
creating workbooks from templates,� 169,� 172
creating worksheet templates,� 170,� 174
creating worksheets,� 7
criteria

multiple, in functions, 73
sort, 146
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Ctrl key
in keyboard shortcuts, 397
selecting noncontiguous cells for printing with, 

322, 325
selecting shapes with, 295, 298
selecting Slicer data with, 231, 236
selecting worksheets for printing with, 320, 321

currency, formatting,� 103,� 105
Custom AutoFilter dialog box,� 127
Custom DPI Setting dialog box, xxviii
customizations, exporting,� 19,� 22
customizing Excel 2010,� 15
customizing the ribbon,� 20
customizing the Quick Access Toolbar,� 18,� 339,� 342
Custom Lists dialog box,� 147,� 150
custom sort, creating,� 146,� 148
custom sort lists, creating and applying,  

147–148,� 150
custom XLM data, removing with Document 

Inspector,� 385
Cycle graphic (SmartArt),� 287

D
data

accessing from mobile devices, xxiii
accessing from the Web, xxiii
adding to Excel tables, 49, 51
analyzing. See data analysis
changing, and impact on calculations. See scenarios
combining. See data consolidation
copying, 37
copying and pasting, limitations of, 175
cutting, 37
deleting, without deleting formatting, 85
distribution, in trendlines. See data distribution 

(trendlines)
dynamic presentation of. See PivotTables; charts
entering, 30
Excel, and other Office documents, combining, 350
Excel table, summarizing, 50, 51
filtering. See filters; PivotTables
finding, 38. See also searching worksheets
focusing, 121. See also PivotTables
forecasting. See trendlines
formatting. See formatting
grouping, 56
imported, 250, 254-255
incorrectly plotted on charts, reasons for, 261
keeping together when printing, 315
manipulating, drawbacks of, 190
manipulating very large data sets, xxii
modifying, 40
numbers. See numbers

organization, changing. See PivotTables
pasting, x, 37
private, removing from workbooks, 385
projection. See trendlines
refreshing, in PivotCharts, 281
refreshing, in PivotTables, 219
related, linking. See linking
relationships, creating. See linking
relationships, in PivotTables, 214
reordering. See sorting
repeating values, entering, 31, 33 
replacing, 38-39, 42-43
restoring, 44
restoring, and change tracking, 376
restoring, after scenario application, 195
samples, creating with RANDBETWEEN, 128
sensitive, protecting by hiding formulas, 381
sensitive, removing with Document Inspector, 385
sets. See scenarios
sharing. See sharing workbooks
sorting. See sorting
source, for PivotTables, 215, 219, 250
subtotals, calculating, 153
summarizing. See charts; data consolidation; 

formulas; functions; sparklines; subtotals
summarizing with AutoCalculate, 129, 133
summarizing, in PivotTables, 237
summarizing very large data sets, xxii
in templates, 168
transposing, 37
validation. See validation rules

data analysis.� See also charts
with Analysis ToolPak, 207
Data Analysis button, 207
descriptive statistics, 207
with Goal Seek, 198
with multiple scenarios, 194
with PivotTables. See PivotTables
with PowerPivot, xxii
with scenarios, 190
with Solver, 201
what-if analysis, 190

Data Analysis button,� 207-208
Data Analysis dialog box,� 208
data bars, xviii,� 108,� 111,� 393

in Excel 2007, 108
in Excel 2010, xviii, xix, 108
gradient fill in, 108
and negative values, 109

data consolidation
adding and removing ranges, 182, 183
cell position and, 182
choosing calculations, 182
defined, 181, 393
links in, 181
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data distribution (trendlines)
Exponential, 274
Linear, 274, 276
Logarithmic, 274
Polynomial, 274
recommended, 275

data entry
ensuring accuracy of, 135
techniques, summarized, 31

data entry tools,� 29
AutoComplete, 31
AutoFill, 30
AutoFill Options button, 32, 34
Fill Series, 30
Pick From Drop-Down List, 31, 33

data points, in charts, formatting,� 268
data series

in charts, formatting, 268
creating with custom sort lists, 148
entering previous values, 31
entering with AutoFill, 30, 31
entering with AutoFill Options, 32
entering with FillSeries, 30, 31
in Excel tables, 50
types of, 31

data types.� See also numbers; text
and changing chart type, 282
currency, 102
dates, 102
and filters, 122
phone numbers, 102

Data Validation button,� 135
Data Validation dialog box,� 135,� 138
&[Date] code, in headers and footers,� 307
dates

adding to page headers and footers, 306, 307
change tracking within, 376
filtering, 122, 125
formatting, 103, 104
and Locale setting, 103
months, sorting, 147
Sort & Filter list options for, 145
sorting, 145

days, filling cells with series,� 32
days of the week, sorting,� 147
debugger warning dialog box (Visual Basic 

Editor),� 336
decimals, displayed as percentages,� 198
default table style, changing,� 97
default workbook,� 2
defining filter rules,� 124
Delete button (comments),� 373,� 375
Delete dialog box,� 12,� 14
deleting background images,� 115,� 118
deleting cells,� 12,� 14

deleting columns,� 12
deleting comments,� 373,� 375
deleting conditional formatting rules,� 107
deleting custom styles,� 91
deleting data,� 85
deleting hyperlinks,� 361
deleting macros,� 337
deleting page breaks,� 313
deleting ranges,� 58
deleting rows,� 12
deleting sparklines,� 279
deleting watches,� 77,� 81
deleting worksheets,� 8,� 10
delimiters,� 251,� 254
dependents

defined, 76, 393
tracing, to identify errors, 76

Descriptive Statistics dialog box,� 208
Design contextual tab (charts)

applying templates from, 269
changing data source from, 262, 265
Chart Styles gallery, 267, 270
choosing layouts from, 267, 270
creating chart templates from, 269
moving charts from, 263, 266

Design contextual tab (Excel table),� 51
Convert To Range button on, 369
converting Excel tables to ranges from, 369

Design contextual tab (Header & Footer),� 304,� 
305,� 307

Design contextual tab (PivotCharts), changing 
chart type from,� 282,� 285

Design contextual tab (PivotTables),� 237,� 239,� 244
detail levels (PivotTable), hiding,� 226
diagrams.� See SmartArt graphics
dialog boxes

displaying errors in, 76
filtering criteria, 123
help with, xxxvii

dictionary, adding words to,� 43,� 46
digital certificates, Office 2010 selfcert.�exe 

accessory,� 386
digital signatures

adding, 386, 387
creating, 386, 387
editing workbooks and, 387
finalizing workbooks and, 387
finding, 386
naming, 387
purchasing, 386, 387

Disable All Macros With Notification (security 
level),� 332

Disable All Macros Without Notification (security 
level),� 332

disabling macros,� 331
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display font, Excel, changing,� 87,� 89
display settings different from book, xxix
displaying comments,� 373,� 374
displaying custom error messages,� 72
displaying errors in a dialog box,� 76
displaying formula details,� 77
displaying headers and footers,� 304
displaying hidden worksheets,� 8,� 10
displaying ranges,� 57
displaying scenarios,� 191
displaying worksheets,� 7
distributing shapes,� 295
distributing workbooks electronically.� See sharing 

workbooks
#DIV/0! error code,� 75
Document Inspector, removing sensitive data 

with,� 385
Document Properties button,� 5
Document Properties panel,� 3-5
dollar sign ($)

in absolute references, 68
in link references, 176

dpi settings, xxviii
dragging

to change margins, 311
to copy formulas, 66
to fill cells, 30
to move chart elements, 268
to move charts, 263, 266
to move shapes, 295
to pivot PivotTables, 219, 221
to resize chart elements, 268
to resize charts, 263
to resize images, 114
to resize shapes, 294
to select cells, 34

drawing shapes,� 294,� 297
Drawing Tools Format contextual tab

aligning shapes with, 295, 298
changing shape formatting with, 294
creating shapes with, 294, 297
distributing shapes with, 295
specifying shape height and width with, 294

dynamic charts.� See PivotCharts
dynamic worksheets.� See PivotTables

E
Edit Comment button,� 373
Edit Formatting Rule dialog box,� 108,� 109,� 111
Edit Hyperlink dialog box,� 363
Edit Links dialog box,� 177,� 179
Edit Name dialog box,� 58

Edit Scenario dialog box,� 192
editing comments,� 373
editing conditional formatting rules,� 107,� 111
editing embedded files,� 355,� 356
editing formulas,� 60
editing headers and footers,� 305
editing hyperlinks,� 361,� 363
editing linked files,� 352
editing macros,� 337,� 338
editing ranges,� 58,� 59
editing shared workbooks.� See sharing workbooks
editing text in shapes,� 295
editing workbooks saved as Web pages,  

inability,� 368
electronic distribution, securing workbooks  

for,� 372
e-mail addresses, creating hyperlinks to,� 360
e-mail messages

creating with hyperlinks, 360
sharing workbooks via, 370, 371

embedding files.� See file embedding
Enable All Macros (security level), not 

recommended,� 332
Enable Content button (macro security),� 331
enabling macros,� 331,� 332
Encarta dictionary,� 44
Encrypt Document dialog box,� 379,� 382
encrypting workbooks.� See passwords
entering data,� 29,� 30
entering data series,� 30
entering ranges in formulas,� 69
equal sign (=)

in formulas, 60
in link references, 176, 177

Equation button,� 296-297,� 299
equations

adding to shapes, 296, 297, 299
adding symbols to, 297, 300
common, listed on Equation button, 297
Excel 2010 improvements, xxi
subscript in, 299

Equation Tools Design contextual tab,� 296,� 299
Error button,� 75
Error Checking button,� 79
Error Checking dialog box,� 76,� 79
error codes�

#####, 75
common, summarized, 75
defined, 393
#DIV/0!, 75
#N/A, in lookup functions, 161, 163
#NAME?, 75
#REF!, 75, 177
#VALUE!, 75
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error messages
adding icons to, 139
Cancel button in, 140
displaying default, 140
displaying with validation rules, 137, 138
Retry button in, 140

errors
auditing, 74
codes. See error codes
displaying custom messages, 72
displaying in dialog box, 76, 79
Error button, 75
finding information about, 75, 79
ignoring, 76
ignoring in AGGREGATE function, 132
in links, 177, 178
messages. See error messages
printing options for, 320
reference, 75
settings, changing, 76
tracing dependents to identify, 75
tracing precedents to identify, 75

Evaluate Formula button,� 77,� 80
Evaluate Formula dialog box,� 77,� 80
examining formulas,� 77,� 80
Excel 2007

data bars in, 108
icon sets in, 109

Excel 2010
64-bit version, xxii
Backstage view, introduced, ix
collaborating on the Web with, xxiii
Compatibility Functions and, xiv
conditional formatting, improved, xviii
custom sort lists in, 148
data bars in, xviii, 108
equations, improved, xxi
Excel Mobile 2010, xxiii
Excel Web App, xxiii
File tab, introduced, ix
functions, backward compatibility, xiii
functions, improved, xii
functions, new naming conventions, xii
functions, saving in older formats, xv
functions, statistical distribution, listed, xii
functions, statistical summary, listed, xiii
icon sets in, xix, 109
image editing, improved, xxi
installing Analysis ToolPak, 207
installing Solver, 201
macro security in, 330
macro security level, default, 332
maximum number of sort levels in, 146
and mobile devices, xxiii
new features in, ix

older functions in, xiii
Paste Live Preview, introduced, x
PowerPivot (Project Gemini), xxii
printing commands, new location of, 309
program window, customizing, 15
Project Gemini (PowerPivot), xxii
ribbon modification options, improved, xi
search filters in, xvii
security levels, changing, 331
Slicers in, xvi
sparklines in, xv
starting, 1, 3
user interface, customizing, 15
workbooks, embedding other Office documents in. 

See file embedding
workbooks, linking to other Office documents. 

See file linking
workbooks, linking to Web. See hyperlinks

Excel, earlier versions of.� See also Excel 2007
custom sort lists in, 148
file formats, 3
macro security in, 330
maximum number of sort levels in, 146
older functions in Excel 2010, xiii
Page Field (Report Filter) area in, 226
Paste Options button, 35
pasting in, 35

Excel file formats
Excel 97-2003 template (.xlt), 169
macro-enabled and disabled, summarized, 330
macro-enabled Excel 2010 template (.xltm), 169
template (.xltx), 169, 171
saving workbooks in, 3
workspace (.xlw), 186

Excel files.� See workbooks
Excel Help button, xxxvii, xxxviii
Excel Help window, xxxviii–xl
Excel Mobile 2010, xxiii
Excel Options dialog box

Add-Ins page, 201, 207
Customize The Quick Access Toolbar page, 18, 25, 

339, 340, 342
Customize The Ribbon page, 20, 26
Trust Center, 331

Excel tables
adding data to, 49, 51
adding fill color to, 98
adding formulas to, 67
adding and removing columns, 50
adding and removing rows, 50
AutoExpansion, 49
converting to ranges, 51, 369
creating, 49, 51
creating charts from, 264
creating PivotTables from, 214
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data series in, 50
defined, 393
Design contextual tab, 51
filtering. See filters
formatting, 96
formulas in, 50, 51
in formulas, 63
introduced, 29
linking, and hidden Totals row, 177
linking to cells in, 177
names, adding to formulas, 69
names, and PivotTables, 214
references to, 177
renaming, 50, 52
resizing, 50
and shared workbooks, incompatibility, 369
summarizing data in, 50, 51
table style gallery, 49
Totals row, 50, 177
VLOOKUP function and, 161

Excel table styles.� See table styles
Excel Web App, xxiii
exclamation point (!), in references,� 176
exercise format, xxix
Expand Dialog button,� 182
Extensible Markup Language (XML), defined,� 394

F
F8 key, stepping through macro instructions with,� 

334,� 335
F11 key, creating default charts with,� 261
features and conventions of book, xxxi
field assignment (PivotTable), previewing,� 219
Field List button,� 216
fields, PivotTable.� See PivotTable fields
&[File] code, in headers and footers,� 307
file embedding,� 355-356

charts, 364
defined, 355, 393
embedding a workbook, 356
embedding in a workbook, 355
locating files to embed, 356, 357
troubleshooting unreadable text, 356
working with embedded files, 355, 356

file formats, Excel.� See Excel file formats
file formats, non-Excel

.htm and .html, 388
Portable Document Format (PDF), 372
XML Paper Specification (XPS), 372

file information.� See workbook properties

file linking
appearance of linked files, 351
and broken links, 350
changing linked files, 350, 352, 353
compared to embedding, 350, 355
creating a link, 350, 352
disadvantages of, 355
displaying linked files, 351
editing linked files, 352, 353
Excel workbooks to other Office documents, 349, 

350, 352
importance of file location, 355
locating files to link to, 351, 352
maintaining links when moving, 350
overview, 349
troubleshooting unreadable text, 356
Web pages and original workbooks, 388

file names, adding to page headers and footers,� 307
File tab, replacement for Microsoft Office button, ix.� 

See also Backstage view
files

creating hyperlinks to, 359, 362
embedded, working with, 355, 356
linked, appearance of, 351
linked, compared to embedded, 350, 355
linked, working with, 350, 351, 352, 353
locating for hyperlinks, 359, 362
location, and file linking, 355
moving, and maintaining links, 350
PDF, creating, 372
sharing. See sharing workbooks
XPS, creating, 372

fill color
adding to cells, 86, 88
adding to Excel table, 98
data bars, 108
and file linking, troubleshooting, 356
No Fill setting, and file linking, 356
SmartArt graphic, changing, 290, 293
sorting by, 146, 152

Fill Days option,� 32
fill handle,� 30

AutoFill Options button, 32, 34
controlling data series entry, 31
copying formulas with, 66
defined, 394
repeating values with, 31, 33

fill operations, options for,� 32
Fill Weekdays option,� 32
FillSeries,� 30,� 31,� 394
filter arrows,� 122,� 125

funnel, 124
in PivotTables, 224
in Report Filter area, 226
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filter indicators, in PivotTables,� 224
filter panel,� 123
filters,� 121,� 122

active cells in, 122
AutoFilter, 122
and AVERAGE function, 129
clearing, 124, 126, 127
creating, 122, 127
criteria, changing, 123
and data types, 122
date, 122, 125
defined, 122, 394
filter arrows, 122, 125
filter panel display, 123
funnel filter arrow, 124
for highest or lowest value, 123
indicators in PivotTable field headers, 224
labels in, 122
options menu, 122
PivotChart, 282, 286
PivotTable, 222, 232, 281
removing, 124, 126, 127, 235
Report Filter area (PivotTables), 226
rules, defining, 124
Search box, 123, 126
search filters, defined, 123
search filters, in PivotTables, 227, 235
Slicers. See Slicers
and SUBTOTAL function, 131
and SUM function, 129
summarizing data, 129, 131
Top 10 filter, 123
turning off, 124

filtering criteria dialog box,� 123
Final, workbook status property,� 385
finalizing changes,� 376
Find And Replace dialog box,� 38,� 40

clearing formatting from, 43
options summarized, 39

Find Format dialog box,� 39,� 41
finding data,� 38.� See also searching worksheets

unique values and, 160
with VLOOKUP function, 161

finding digital signatures,� 386
finding error information,� 75
finding maximum value,� 61
finding minimum value,� 61
finding sensitive data,� 385
first row or column, unhiding,� 12
focusing data,� 121
font, changing,� 93
font color, sorting by,� 146
Font Color button,� 94

font size, changing,� 87
footers, page

adding dates and times to, 306, 307
adding file names to, 307
adding graphics to, 306, 308
adding page numbers to, 306
adding worksheet names to, 306
adding to worksheets, 304
and charts, 305
creating, 306
&[Date] code in, 307
displaying, 304
editing, 305
&[File] code in, 307
removing with Document Inspector, 385
introduced, 304
page numbers in, 305
&[Picture] code in, 308
predefined, adding to worksheets, 305
resizing, and effect on worksheet body, 311
switching to, from header, 307
workbook name in, 305

forecasting data.� See trendlines
format, previewing.� See live preview
Format As Table button,� 49,� 255
Format As Table dialog box,� 49,� 51,� 255
Format Axis dialog box,� 271
Format button,� 11
Format Cells dialog box,� 90

Alignment page, 92
Borders page, 86
creating PivotTable styles with, 244, 248
defining table styles in, 97
editing conditional formatting rules in, 108
Fill page, 97
hiding formulas in, 381, 383
locking and unlocking cells from, 381, 383
Number page, 93, 102, 103, 104
PivotTables and, 242, 245
Protection page, 381, 383

Format contextual tab (charts),� 268
Format dialog box (charts),� 269
Format Painter button,� 91
Format Picture button (page headers and footers),� 

306,� 308
Format Picture dialog box (page headers and 

footers),� 308
Format Shape button (SmartArt),� 290,� 292
Format Shape dialog box (SmartArt),� 290,� 292
Format Trendline dialog box,� 274,� 276
formats, conditional.� See conditional formatting
formats, Excel.� See Excel file formats
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formatting
alignment, 92
applying with Format Painter, 91
boldfacing, 85, 87
buttons, 85, 86
cell, copying, 32, 34
cell, deleting, 85
cell, preserving when deleting data, 85
cell, and VLOOKUP function, 163
changing based on values. See conditional 

formatting
changing, with macros, 333
chart elements, 268
charts, 267
clearing, 43, 85
column, changing, 86
conditional. See conditional formatting
currency, 103, 105
dates, 103, 104
defined, 394
Excel display font, changing, 87, 89
Excel tables. See table styles
font size, changing, 87
fonts, 93
ignoring, in cell copying, 32
inserting and, 11, 13
italics, 88
labels, 83, 84
Mini Toolbar, 86
noncontiguous cells, 88
numbers, 93, 101, 103, 105
pasting and, 37
phone numbers, 102, 105
PivotTables, 242
row, changing, 86
saving. See themes; styles; templates, workbook
searching for, 39, 41
shapes, 294
SmartArt graphics, 290
sparklines, 279
Special formats, 102
styles. See styles
text in shapes, 295, 300
themes. See themes
time, 93
tools, 85, 86

formatting (HTML), workbook labels for Web 
pages,� 388

Formatting Options action button,� 243
Formula AutoComplete,� 62,� 69,� 70 394

Compatibility Functions in list, xiv
formula bar

changing data in, 40
contents of, 34
defined, 394

editing formulas in, 60
Excel display font, changing, 87, 89
hiding, 23
phone numbers in, 102

formula box.� See formula bar
formulas

absolute references in, 81
adding contiguous cells to, 64
adding Excel table names to, 69
adding to Excel tables, 67
adding functions to, 60
adding noncontiguous cells to, 64
Calculate Now button, 61
conditional, introduced, 70
copying and pasting, 65, 68
creating, 60, 62, 69
defined, 60, 394
details, displaying, 77
displaying messages with, 70
editing, 60
entering ranges in, 69
equal sign (=) in, 60
erroneously treated as text, 60
errors. See errors
examining, 77, 80
Excel tables in, 63
in Excel tables, 50, 51
Formula AutoComplete, 62, 69, 70
hiding, 381
linking, 176
multiple worksheets and, 17
and PivotTables, 238, 241
protecting from unauthorized access, 381, 383
ranges in, 56, 62
relative references in, 65, 81
revising, 60
scenarios and, 191
searching in, 40
square brackets in, 63
troubleshooting, 60
unrecognized text in, 75

Forward button (Help), xxxix
From Text button (importing),� 251,� 254
Function Arguments dialog box,� 70,� 71
functions.� See also specific functions

adding to formulas, 60
arguments, 62, 70
and AutoCalculate, 129
automatic recalculation of, 128
Compatibility Functions, xiv
conditional, summarized, 71
defined, 60, 394
earlier versions of, in Excel 2010, xiii
Excel 2010, backward compatibility, xiii
Excel 2010, improved, xii
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functions (continued)
Excel 2010, naming conventions, xii
Excel 2010, saving in older formats, xv
Function Arguments dialog box, 70
lookup. See VLOOKUP function; HLOOKUP function
multiple criteria in, 73
naming conventions in Excel 2010, xii
statistical distribution, listed, xii
statistical summary, listed, xiii
summary (PivotTable), changing, 237, 240
volatile, defined, 128

funnel icon, in filter arrow,� 124
future values, projecting.� See trendlines

G
Get External Data button,� 251,� 254
GETPIVOTDATA function,� 238,� 241
goals

testing with Goal Seek, 198
testing with Solver, 201

Goal Seek
approximation to target value, 199
business planning and, 198
compared to Solver, 201
defined, 394
finding target values with, 198, 199
location of, 198
saving and closing with, 199
viewing results, 199, 200

Goal Seek dialog box,� 198-200
Goal Seek Status dialog box,� 199
Go to Footer button,� 307
grand total level,� 156
grand total row (PivotTables),� 237,� 239
grand totals, in PivotTables,� 243
Grand Totals button (PivotTables),� 237,� 239
graphics, in page headers and footers,� 306,� 308
graphics, creating.� See SmartArt graphics
graphs.� See charts
gridlines, adding to charts,� 268
Gridlines button (charts),� 268
grouping related data,� 56
grouping workbooks.� See workspaces

H
Header button (page headers and footers),� 305
Header & Footer button,� 304,� 306

and charts, 305
headers, column and row

changing formatting with, 86
and charts, omitting from, 262
defined, 36

and displaying unique values, 133, 134
filter arrow in, 125
setting page breaks with, 313
shapes as, 295
sorting and, 146
and SUBTOTAL function, 130

headers, field (PivotTable).� See PivotTable fields
headers, page

adding dates and times to, 306, 307
adding file names to, 307
adding graphics to, 306, 308
adding page numbers to, 306
adding worksheet names to, 306
adding to worksheets, 304
and charts, 305
creating, 306
&[Date] code in, 307
defined, 394
displaying, 304
editing, 305
exiting editing mode, 308
&[File] code in, 307
removing with Document Inspector, 385
page numbers in, 305
&[Picture] code in, 308
predefined (Auto Headers), adding to 

worksheets, 305
resizing, and effect on worksheet body, 311
switching to, from footer, 307
workbook name in, 305

height, row, changing,� 11
height, shape, changing,� 294
Help button,xxxvii, xxxviii
Help window, xxxviii–xl
hidden rows

cause of errors, 177
removing with Document Inspector, 385
ignoring in AGGREGATE function, 132
Totals row, and linking, 177

hidden worksheets
removing with Document Inspector, 385
redisplaying, 8, 10

Hide Detail button, in outline area,� 155,� 158
Hide Detail button (PivotTables),� 226,� 234
hiding columns,� 12,� 13
hiding detail levels (PivotTable),� 226
hiding Document Properties panel,� 4
hiding formula bar,� 23
hiding formulas,� 381,� 383
hiding labels,� 23
hiding PivotTable Field List task pane,� 224
hiding ribbon,� 23
hiding rows,� 12

in subtotals, 155, 158
hiding tracer arrows,� 76,� 79,� 80
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hiding worksheets,� 8,� 9
Hierarchy graphic (SmartArt),� 287,� 290
Highlight Changes dialog box,� 375,� 376,� 377,� 378

List Changes On A New Sheet check box, effects 
of, 376, 378

sharing workbooks from, 375
Track Changes While Editing check box, effects of, 

375
tracking specific changes from, 376

history, of workbook changes, keeping,� 369,� 376,� 378
History worksheets

adding, 376, 378
deleted when saving workbook, 376

HLOOKUP function,� 163.� See also VLOOKUP function
.�htm (HTML) file format,� 388
.�html file format,� 388
HTML files,� 388,� 394

saving workbooks and worksheets as, 388
Hyperlink button,� 358,� 361
hyperlinks

changing cell reference, 360
color of, 358
compared with links, 358
creating, 358, 359, 361, 362
defined, 349, 358, 394
deleting, 361
editing, 361, 363
to e-mail addresses, creating, 360
to existing files, creating, 359, 361
locating files for, 359, 362
locating Web pages for, 359
to locations in same workbook, 358
mailto, effect of clicking, 361
mailto, creating, 360
to new document, 359
opening, 361
to other Web documents, 358
shortcut menu options, 361
specifying text for, 361
targets, listed, 359
to Web pages, creating, 359

Hypertext Markup Language files.� See HTML files

I
icon sets,� 109,� 111

defined, 394
in Excel 2007, 109
in Excel 2010, xix, 109
rules, changing, 109, 111

icons
displaying embedded files as, 356
displaying linked files as, 351
sorting by, 146

IF function,� 70,� 134
displaying messages with, 71, 73

IFERROR function,� 71
ignoring errors,� 76
images

adding borders to, 114
adding to worksheets, 113, 116
background, deleting, 115, 118
background of, removing, xxi, 114, 116
background, repeating, 115, 117
background, as watermarks, 115
changing, 114
editing improvements in Excel 2010, xxi
moving, 117
resizing, 114, 117

Import Data dialog box,� 254
Import/Export button,� 18,� 22
Import Text File dialog box,� 251,� 254
importing data files,� 250,� 252,� 254
importing text files,� 253–254
Info page (Backstage view).� See Backstage view 

(Info page)
information bar.� See status bar
information retention policies, and workbook 

change histories,� 369
Insert dialog box,� 12,� 14,� 170,� 174

adding worksheets from, 171
General page, 170
Spreadsheet Solutions page, 170

Insert Function dialog box,� 50,� 60
conditional functions in, 70

Insert Hyperlink dialog box,� 358,� 361
creating mailto hyperlinks with, 361
specifying text to display in, 361

Insert Object dialog box (file embedding),  
355,� 356

Insert Options button,� 11,� 13
Insert Picture dialog box,� 113,� 116
Insert Picture dialog box (page headers and 

footers),� 308
Insert Slicer button,� 229,� 235
Insert Slicers dialog box,� 229,� 235
Insert Worksheet button,� 7
inserting cells,� 12,� 14
inserting columns,� 11,� 13
inserting rows,� 11,� 13
installing Analysis ToolPak,� 207
installing Solver,� 201
Internet, viewing workbooks on,� 388
intranets, viewing and sharing workbooks via,� 388
invisible content, removing with Document 

Inspector,� 385
Italic button,� 87
italics, applying to data,� 88
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K
keyboard shortcuts,� 397
keywords,� 3,� 5

L
labels, row and column

in filters, 122
formatting, 83, 84
formatting for Web pages (HTML), 388
hiding, 23
as range names, 57
shapes as, 295
in templates, 168

landscape mode (orientation),� 311,� 316,� 394
Layout contextual tab (charts)

creating trendlines from, 274, 276
customizing charts from, 267

layouts, chart.� See charts
legends.� See charts, legends
levels, subtotal.� See subtotal levels
Linear data distribution (trendlines),� 274,� 276
Line button (sparklines),� 277,� 279
linking,� 176

broken links, finding and fixing, 177, 179
to cells in Excel tables, 177
creating a link, 176, 177
defined, 394
and deleted source worksheets, 177, 178
equal sign (=) in, 176, 177
errors in, 177, 178
with formulas, 176
and hidden Excel table Totals row, 177
introduced, 168
references in, 176, 178
#REF! error code in, 177, 178
and renamed source worksheets, 177
source cells, 176
target cells, 176
updating linked cells, 177
workbooks to other Office documents. See file 

linking
workbooks to the Web. See hyperlinks

links, broken.� See linking
List graphic (SmartArt),� 287
live preview

defined, 394
of shapes, 294
of styles, 90

Live Preview, Paste,� 36
loan payments, calculating with PMT function,� 62

locked cells
and hidden formulas, compared, 381
defined, 381, 394
locking and unlocking, 381
protecting, 381, 383

logos.� See graphics
Look In navigational tool

creating hyperlinks in current workbook with, 
359, 362

finding files for hyperlinks with, 359, 362
finding Web pages for hyperlinks with, 359

lookup functions.� See VLOOKUP function, 
HLOOKUP function

lookup_value argument, in VLOOKUP function,� 161

M
Macro dialog box,� 332,� 334

deleting macros in, 337
displaying from Quick Access Toolbar, 339
running macros from, 334, 336
running macros without, 340
stepping through macros with, 333, 335

macro-disabled workbooks,� 330
macro-enabled workbooks,� 330,� 331
macros

in active workbook, viewing, 332
adding to Quick Access Toolbar, 340, 341, 342
assigning to shapes (custom buttons), 341, 343
Auto_Open, 344, 345
changing formatting with, 333
code, viewing, 332, 334
creating, 336, 337
defined, 329, 394
deleting, 337
Disable All Macros With Notification security 

level, 332
Disable All Macros Without Notification security 

level, 332
disabling, 331
editing, 337, 338
Enable All Macros security level, not 

recommended, 332
enabling, 331, 332
file formats for, summarized, 330
instructions, stepping through, 333, 335
location on ribbon, 329
naming, 337
opening macro-enabled workbooks, 331
in other workbooks, viewing, 332
recording, 336, 337
running, 334, 336
running from custom buttons (shapes), 341, 344
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running from Quick Access Toolbar, 343
running from the ribbon, 339
running when workbook opens, 344
saving changes to, 339
security and, 330-332
Security Warning Message Bar, 331, 332
selecting cells with, 333
stepping through, 333, 335
stopping recording, 337, 338
viewing, 332, 334
viewing code, 332, 334
viruses and, 330, 332

Macros button,� 332,� 334
recording Auto_Open macro with, 345
recording macros with, 336, 337

magnification level
changing. See zooming
changing globally, xxvii

mailto hyperlinks
and Microsoft Outlook, 361
and Microsoft Outlook Express, 361
and Windows Mail, 361
creating, 360
defined, 394
effect of clicking, 361

managing ranges,� 58
Margins button (Backstage view Print page),� 310,� 318
margins, worksheet,� 310

changing, by dragging, 311
custom, setting, 310
default, 310
displaying, 310
predefined, 310
predefined, setting, 318

mathematical equations.� See equations
Matrix graphic (SmartArt),� 287
MAX function,� 61
maximum number of cells in scenarios,� 195
maximum value

advantage of identifying, 55
finding, 61
in Solver objectives, 202, 204

Merge And Center, defined,� 394
merging workbooks,� 371
Message Bar, macro security warning on,� 331,� 332
messages

e-mail. See e-mail messages
entry, displaying with validation rules, 137, 138
error, adding icons to, 139
error, displaying custom, 72, 137, 138
error, displaying default, 140
error, displaying with validation rules, 137, 138

Microsoft Bing search engine.� See Bing search 
engine

Microsoft Encarta dictionary.� See Encarta 
dictionary

Microsoft Excel 2010.� See Excel 2010
Microsoft Excel Help button, xxxvii, xxxviii
Microsoft Office 2010.� See Office 2010
Microsoft Office button, replaced by File tab, ix
Microsoft Office.�com graphics.� See Office.�com, 

graphics
Microsoft Outlook, and creating mailto 

hyperlinks,� 361
Microsoft Outlook Express, and creating mailto 

hyperlinks,� 361
Microsoft PowerPoint 2010.� See PowerPoint 2010
Microsoft Product Support Services, xli
Microsoft Visual Basic Editor.� See Visual Basic Editor
Microsoft Visual Basic for Applications (VBA).� 

See Visual Basic for Applications (VBA) 
programming language

Microsoft Word 2010.� See Word 2010
MIN function,� 61
minimum value

advantage of identifying, 55
finding, 61
in Solver objectives, 202

Mini Toolbar,� 86
mobile devices

accessing Excel data from, xxiii
and Excel 2010, xxiii
Excel Mobile 2010, xxiii

Modify Button dialog box,� 343
monitoring values in cells,� 77,� 78
months

entering series with AutoFill, 30
sorting, 147

Move Chart button,� 263,� 266
Move Chart dialog box,� 263,� 266
Move or Copy dialog box,� 7,� 9
Move Down button,� 18
Move Up button,� 18
moving cells,� 12,� 14
moving chart elements,� 268
moving charts,� 263,� 266
moving through comments,� 374
moving images,� 117
moving page breaks,� 314
moving shapes,� 295
moving to cells,� 34
moving worksheet columns,� 35
multiple criteria, in functions,� 73
multiple scenarios

applying, 194, 195
and values in same cell, 194
viewing in single worksheet. See scenario 

summaries
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N
#N/A error code, in lookup functions,� 161,� 163
Name box, creating ranges in,� 57,� 59
#NAME? error code,� 75
Name Manager dialog box,� 58,� 59
named ranges.� See ranges
naming digital signatures,� 387
naming macros,� 337
naming scenarios,� 191,� 192
networks, sharing workbooks over,� 370,� 388
New Comment button,� 373,� 374
New Formatting Rule dialog box,� 107,� 109
New Name dialog box,� 56,� 60
New PivotTable Quick Style dialog box,� 244,� 247

Preview pane in, 244, 248
New Range dialog box,� 382,� 384
New Table Quick Style dialog box,� 96,� 97
Next button (comments),� 374
noncontiguous cells, adding to formulas,� 64
Normal view, setting page breaks in,� 313,� 317
NOW function,� 61
Number Format button,� 104
number formats, applying to PivotTables,  

242,� 245
numbers.� See also values

1000 separator (,), in charts, 271
adding text to values, 103, 106
currency, formatting, 103, 105
dates, formatting, 103, 104
decimal places, in charts, 271
decimals displayed as percentages, 198
formatting, 101, 103, 105
formatting, changing, 93
in charts, formatting, 271
negative, and data bars, 109
negative, displaying, 103
page. See page numbers
phone numbers, formatting, 102, 105
Sort & Filter list options for, 145
sorting, 144, 147
specifying in validation rules, 138
summarized in PivotTables, 237
target, finding with Goal Seek, 198, 199
target, finding with Solver, 201

O
Object button (file embedding),� 355,� 356
Object button (file linking),� 350,� 352
Object dialog box (file embedding), Link To File 

check box, embedding and,� 355

Object dialog box (file linking),� 350,� 352
creating links in, 351
Display As Icon check box, 351
Link To File check box, linking and, 351, 353

objectives, Solver
maximum value, 202, 204
minimum value, 202
restricting to specific value, 202
setting, 202, 203

Office 2010
selfcert.exe (digital certificate) accessory, 386
system installation CD, 202, 207
themes in, 96

Office 2010 documents
embedding in workbooks, 355
embedding workbooks in, 355
linking to workbooks, 349, 350
pasting charts into, 364

Office.�com
graphics (SmartArt), 287
templates, 169

Office Marketplace, digital signatures available 
from,� 386,� 387

Office theme,� 94
Office Themes, and copying worksheets,� 8
opening hyperlinks,� 361
opening macro-enabled workbooks,� 331
opening workbooks, running macros when,� 344
opening workbooks saved as Web pages,� 388
operations, comparison, in Solver problems,� 203,� 205
Options contextual tab (PivotTable),� 229,� 235,  

237,� 239
order

of conditional formatting rules, changing, 107
of fields in PivotTables, 217
of printed pages. See page order (printing)
of shapes, changing, 296, 299
sort. See sort order
of worksheets, changing, 8, 9

organizational chart, Add Shape button options,� 290
orientation.� See page orientation
Orientation button (Backstage view Print page),� 316
outline area,� 154
outline levels.� See subtotal levels
Outlook 2010, sharing workbooks with,� 370

P
Page Break Preview button,� 312
Page Break Preview mode,� 312

page order indicators in, 314
selecting pages in, 322
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page breaks,� 312
blue lines representing, 313
defined, 312
deleting, 313
moving, 314
Page Break Preview mode, 312
resetting all, 313
setting from cell, 314
setting manually, 313, 317
setting in Normal view, 313, 317
single, inserting, 314

Page Down key, navigating print previews with,� 312
Page Field area.� See Report Filter area
page footers.� See footers, page
page headers.� See headers, page
Page Layout button,� 304
Page Layout view

editing workbooks in, 304
headers and footers in, 304
switching to, 304, 306

page numbers
adding to page headers and footers, 306
in page headers and footers, 305

page order (printing),� 314
changing, 314, 318
indicators, in Page Break Preview mode, 314
keeping data together with, 315

page orientation
changing, 311, 316
landscape mode, 311, 316
portrait mode, 311

Page Setup dialog box
changing page order in, 314, 318
changing print page order in, 322
errors, printing options for, 320
fitting worksheets on printed page with, 312, 317
Header/Footer page, and charts, 305
positioning print area in, 322, 325
printing titles in, 323, 324
setting custom margins in, 310

pages, printed.� See printing
Page Up key, navigating print previews with,� 312
parts of worksheets, publishing as Web pages,� 389
parts of worksheets, printing.� See printing
passwords

creating, 380
recommendations for, 380
removing from workbooks, 380
setting for ranges, 382
setting for workbooks, 379
setting for worksheets, 381, 384

Paste button,� 37
Paste gallery,� 35
Paste Live Preview,� 35

introduced, x

overview of, x
turning on, 36

Paste Options button,� 36
defined, 394
in earlier versions of Excel, 35
turning on, 36

Paste Picture button (pasting charts),� 364
Paste Preview.� See Paste Live Preview
Paste Special dialog box,� 36
pasting,� 37

in earlier versions of Excel, 35
Excel charts into other Office documents, 364
formulas in cells, 65
Paste Live Preview, x, 35
previewing, 35
specialized, 37
undoing, 36

pattern, background, creating,� 115,� 117
PDF (Portable Document Format) files, saving 

workbooks as,� 372
percentages

decimals displayed as, 198
in Values area (PivotTables), 238, 240

personal information, removing with Document 
Inspector,� 385

phone numbers
formatting, 102, 105
troubleshooting, 103

phones, accessing Excel data from, xxiii
photos.� See images
Pick From Drop-Down List (Excel functionality)

data entry with, 31, 33
defined, 31, 394

Picture button (page headers and footers),� 308
&[Picture] code, in headers and footers,� 308
Picture graphic (SmartArt),� 287
Picture Tools Format contextual tab,� 113
pictures.� See images
PivotCharts

and changes to underlying PivotTables, 281, 283
changing chart type, and wrong data type, 282
changing data in, 283
creating, 281, 283
creating from existing PivotTables, 281
defined, 394
filtering, 282, 286
filtering PivotTables and, 281
introduced, 259, 281
refreshing, 281
restoring after filtering, 282
type, changing, 282, 285

pivoting PivotTables,� 218,� 221,� 394
PivotTable button,� 220

creating PivotCharts from, 281, 283
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PivotTable Field List task pane,� 220
Choose Fields To Add To Report area, 216
displaying, 216
Drag Fields Between Areas Below area, 216
filter menu, 223, 232
filtered field names in, 224
filtering in, 223
hiding, 224
introduced, 215
Report Filter area in, 225, 233
sorting in, 223

PivotTable fields
assigning to PivotTable areas, 216, 220
defined, 394
dragging to Report Filter area, 225, 233
filtered names in PivotTable Field List task pane, 

224
filtering on, 223
filtering items in, 223
filtering in Report Filter area, 226
headers, dragging to assign fields, 216, 220
headers, filter arrows in, 224
order of, 217
selecting all items for filtering, 223

PivotTable filter menu
check marks in, 223, 232
field items in, 223
Select All check box, 223, 232

PivotTables
applying styles, 244, 246
assigning fields to, 216, 220
changing, and dependent PivotCharts, 281, 283
changing source data and, 219
Column Labels area, 217, 221
Column Labels header, filter arrows in, 224
conditional formatting in, 243, 250
creating, 214, 220
creating from Excel tables, 214
creating on existing worksheet, 215
creating on new worksheet, 215
creating, structure required for, 214
creating styles, 244, 247
data relationships in, 214
data source for, 215, 250, 254
Defer Layout Update check box, 219
defined, 394
details, importance of, 222
existing, creating PivotCharts from, 281
Field List button, 216
fields. See PivotTable fields
filter arrows in, 224
filter indicators in, 224
filter menu. See PivotTable filter menu
filtering, 222, 232
filtering by multiple values, 226, 233

filtering by one value, 226
filtering, and PivotCharts, 281
filters, removing, 233
formatting, 242
and formulas, 238, 241
grand total row, formatting, 237
Hide Detail button, 226, 234
hiding detail levels, 226, 234
importing data for, 250, 254
introduced, 211
maximizing display, 224
percentages in Values area, 238, 240
and PivotCharts, compared, 281
pivoting, 218, 221
PivotTable Field List task pane, 215, 220
preview of field assignment, 219
redraw time, and data on other computers, 219
redraw time, and large data sets, 219
refreshing data in, 219
renaming, 237, 239
Report Filter area in, 225, 233
Row Labels area, 217, 220
Row Labels header, filter arrows in, 224
search filters in, xvii, 227, 235
Second Row Stripe style, 248
Show Detail button, 226, 234
showing detail levels, 234
Slicers, xvi, 228. See also Slicers
structure required to create, 214
styles, banded columns, 245
subtotal rows, formatting, 237
summarizing data in, 237
summary functions, changing, 237, 240
Tools contextual tab, 216
update, delaying, 219
updating, 219
Values area, 221
Values area, data display in, 238, 240
Values area, data summary in, 237
Values area, formatting, 242, 245
on Web pages, loss of interactivity, 389

PMT function,� 61
popup tips.� See ScreenTips
Portable Document Format (PDF) files

saving workbooks as, 372
setting size of, 372

portrait mode (orientation),� 311,� 395
PowerPivot (Project Gemini), xxii
PowerPoint 2010, linking presentations to Excel 

workbooks,� 352
ppi settings, xxviii
practice files

downloading, xxxiii
list of, xxxiii
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precedents
defined, 75, 395
tracing, to identify errors, 75

previewing field assignments (PivotTable),� 219
previewing formats.� See live preview
previewing pasted data with Paste Live  

Preview, x,� 35
previewing, print

Backstage view, 309, 312, 316
number of pages, 312
page breaks, 312
Page Layout view, 304
Print Preview, limitations of, 304
saving money with, 327

previewing worksheet templates,� 171
Previous button (comments),� 374
primary key column

defined, 395
unique values, 160

print area
centering, 322
defining, 322, 325
positioning on page, 322

Print Area button,� 322
Print button (Backstage view Print page),� 318
Print Preview, limitations of,� 304
Print Selected Chart button (Backstage view Print 

page),� 326
Print Titles button,� 323,� 324
Print What button (Backstage view Print page),� 320

printing charts with, drawbacks of, 326
printer, choosing,� 318
printing

Backstage view, 309
centering print area, 322
charts, 326
charts, importance of selecting, 326
charts, and Print What button, 326
clearing selected cells, 322, 326
collating copies, 318
commands, Excel 2010 location of, 309
customizing, 318
entire worksheet, 320
and errors, options for, 320
fitting worksheets on pages, 312, 317, 322, 325
footers and, 304
headers and, 304
Help topics, xxxvii
multiple copies, 318
number of pages required, viewing, 312
page breaks, 312. See also page breaks
page order, 314
parts of worksheets, 322
positioning print area, 322
print area, defining, 322

printer, choosing, 318
print titles, 323
repeating rows or columns in, 323, 324
scaling worksheets for specified pages, 322, 325
selecting noncontiguous cells for, 322
selecting worksheet elements for, 320
selecting worksheet pages for, 322
selecting worksheets for, 320, 321
worksheets, 318, 321
all worksheets in workbook, 320

private data, removing from workbooks,� 385
Process graphic (SmartArt),� 287,� 288
program window, Excel 2010

customizing, 15
maximizing space, 23
resizing, xxvi

Project Gemini (PowerPivot), xxii
projecting values.� See trendlines
Properties dialog box,� 3,� 5
properties, file.� See workbook properties
Protect Sheet button,� 380,� 384
Protect Sheet dialog box,� 380,� 384

selecting elements to protect, 381
setting passwords in, 381, 384

protecting formulas from unauthorized access,� 
381,� 383

protecting locked cells from unauthorized access,� 
381,� 383

protecting ranges from unauthorized access,  
381,� 384

protecting workbooks from unauthorized access,� 
379,� 382,� 385

protecting worksheets from unauthorized access,� 
380,� 384

Publish As PDF Or XPS dialog box,� 372
Publish As Web Page dialog box,� 389,� 391
publishing entire workbooks to the Web,� 389
publishing parts of workbooks to the Web,� 389,� 391
publishing workbooks to the Web,� 389,� 391
purchasing digital signatures,� 386,� 387
Pyramid graphic (SmartArt),� 287

Q
Quick Access Toolbar

adding buttons to, 18, 25
adding macro buttons to, 340, 342
adding multiple macro button to, 341
adding View Macros button to, 339, 342
changing buttons on, 341
changing button positions, 19
customizing, 18, 339, 342
defined, 395
displaying Macros dialog box from, 339



424    Quick Access Toolbar (continued)

Quick Access Toolbar (continued)
exporting customizations, 19
location, 18
Redo button, 44
removing buttons, 19
resetting, 19
running macros from, 340, 342, 343
Undo button, 44

quotes (quotation marks), in text strings,� 104,� 106

R
RAND function,� 128,� 134
RANDBETWEEN function,� 128
random characters, passwords and,� 380
random rows, selecting,� 128
random values, generating,� 128
range_lookup argument, in VLOOKUP function,� 161
ranges

changing definition of, 58
comments, 56
converting Excel tables to, 369
copying, 35
creating, 56, 58
creating series of, 57
data consolidation and, 182
defined, 34, 56, 393, 394, 395
deleting, 58
displaying, 57
editing, 58, 59
entering in formulas, 69
filtering, 58
formatting. See formatting
in formulas, 56
labels as range names, 57
managing, 58
Name Manager dialog box, 59
names, in formulas, 62
New Name dialog box, 56, 60
printing, 322
protecting from unauthorized access, 381, 384
selecting, 34
selecting for sparklines, 277, 279
setting availability of, 56
setting passwords for, 382
VLOOKUP function and, 161

read-only workbooks, creating,� 372,� 385
recalculation time

displaying, 61
updating, 61

reconciling changes in shared workbooks,� 369
record of changes, keeping.� See change tracking, 

histories
Record Macro dialog box,� 336,� 337
recording Auto_Open macro,� 345

recording macros,� 336,� 337
stopping, 337

redoing changes,� 44
#REF! error code,� 75

in link references, 177, 178
references

3-D, 176
absolute. See absolute references
cells in, 176
to cells in the same workbook, 177
to cells in the same worksheet, 177
defined, 393
dollar sign ($) in, 176
errors, 75
to Excel tables, 177
exclamation point (!) in, 176
hyperlink, changing, 360
in linking, 176, 178
relative. See relative references
single quotes in, 176
in Solver problems, 203
square brackets [ ] in, 176
types of, changing, 68, 69
types of, summarized, 68
to Web. See hyperlinks
workbooks in, 176
worksheets in, 176

Refresh All button,� 18
Refresh button (PivotChart),� 281,� 285
refreshing data in PivotTables,� 219
refreshing, defined,� 395
refreshing PivotCharts,� 281
refreshing Web pages,� 389
rejecting changes,� 376
related data

grouping, 56
linking, 175

Relationship graphic (SmartArt),� 287
relative references,� 66,� 81

changing to absolute references, 68, 69
defined, 65, 395
usefulness of, 66

Remove All button (Document Inspector),� 385
Remove Arrows button,� 78
removing all changes,� 376
removing background of images,� 114,� 116
removing changes,� 376
removing filters,� 124,� 126,� 127,� 232,� 236
removing passwords from workbooks,� 380
removing scenarios,� 191,� 193
renaming Excel tables,� 50,� 52
renaming worksheets,� 7,� 9
reordering data.� See sorting
repeating background images,� 115,� 117
repeating values with the fill handle,� 31,� 33
Replace All,� 39
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replacing data,� 38,� 42
Report Filter area

in earlier versions of Excel (Page Field area), 226
filter arrows in, 226
in PivotTables, 225, 233

reports, Word 2010, linking to workbooks,� 349
Research task pane,� 44

Bing search engine, 44
Encarta dictionary, 44
Thesaurus, 44, 47
translation tools, 45, 47

research tools,� 44.� See also Research task pane
resetting all page breaks,� 313
resize handles

chart, 263
chart element, 268
Excel table, 50
shape, 294

resizing chart elements,� 268
resizing charts,� 263
resizing headers and footers,� 311
resizing images,� 114,� 117
resizing program window, xxvi
resizing ribbon, xxvi
resizing shapes,� 294
resizing sparklines,� 279,� 280
resizing worksheets,� 312,� 322
resolution.� See screen resolution
restoring data,� 44

with change tracking, 376
after scenario application, 195

restoring functionality to finalized workbooks,� 385
reviewing changes,� 376,� 378

all changes, 376
since a specific date, 376
turning off workbook sharing, importance of, 376

revising formulas,� 60
ribbon

button appearance, xxvi
commands on, xxv
customizing, xi
decreasing width of, xxvi
defined, 395
dynamic nature of, xxv
Excel 2010, modifying, xi
exporting customizations, 22
groups, displaying all commands in, xxvi
hidden groups, displaying, xxvi
hiding and displaying, 23
introduced, ix
Main Tabs, 20
modifying in Excel 2010, xi
overview of, xxv
resetting, 19
restoring, 23

running macros from, 339
tabs. See ribbon tabs
tabs and groups, renaming, 22
Tool Tabs, 20
width, changing, xxvi

ribbon tabs
adding groups to, 21
changing groups on, 21
changing order of, 20, 26
creating custom, 21, 26
hiding, 20
removing groups from, 21

rotating shapes,� 294
Row Labels area, Row Labels header.� See PivotTables
rows, Excel table

adding and removing, 50
creating, 49
references to, 177

rows, worksheet
changing height, 11
changing multiple, 11
copying, 35
defined, 395
deleting, 12
filtering. See filters
formatting, 86
headers. See headers, column and row
headers, defined, 35
hidden, and SUM and AVERAGE functions, 129
hidden, finding and removing with Document 

Inspector, 385
hidden, ignoring in AGGREGATE function, 132
hidden, restoring with Show Detail button, 155
hiding, 12
hiding with Hide Detail button, 155, 158
hiding labels, 23
hiding and showing with level buttons, 156, 159
inserting, 11, 13
labels. See labels, row and column
labels as range names, 57
random, selecting, 128
repeating in printouts, 323
selecting, 35
showing with Show Detail button, 155, 158
sorting. See sorting
unhiding, 12

rules
conditional formatting. See conditional formatting
filter, defining, 124
validation. See validation rules

running macros,� 334,� 336
running macros from shapes (custom buttons),� 

341,� 344
running macros when workbooks open,� 344
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S
sample data, creating with RANDBETWEEN, �128
Save As command,� 3,� 5
Save As dialog box,� 5

Excel 97-2003 file format (.xlt) in, 169
macro-enabled Excel 2010 template file format 

(.xltm) in, 169
PDF format in, 372
saving workbooks as Web pages in, 388, 389
template file format (.xltx) in, 169
XPS format in, 372

Save button,� 6
Save Chart Template dialog box,� 272
Save Current Theme dialog box,� 96,� 100
Save & Send page (Backstage view).����� See Backstage 

view (Save & Send page)
Save Template button (charts),� 269
Save Workspace dialog box,� 184,� 185
saving conditional formatting rules,� 107
saving formatting.� See templates, workbook
saving workbooks,� 3,� 5,� 6

for electronic distribution, 372
recommended frequency, 3
Save As command, 3
specifying file formats, 3
as Web pages. See Web pages

Scaling button (Backstage view Print page),  
312,� 317

scaling worksheets,� 322
Scenario Manager dialog box,� 190,� 192

applying multiple scenarios with, 194, 195
scenarios

alternative values in, 190
creating, 190, 192
creating from Solver results, 203
defined, 395
displaying, 191, 193
formulas and, 191
identifying cells for, 191, 192
introduced, 190
maximum number of cells in, 195
multiple, applying, 194, 195
multiple, and values in same cell, 194
multiple, viewing in single worksheet.  

See scenario summaries
naming, 191, 192
of original worksheet, importance of, 191
removing, 191, 193
saving and closing with, 191
Scenario Manager, 190, 192
scenario summaries, 194, 197
“undo,” creating, 195
what-if analysis and, 190

scenario summaries
cells, displaying, 194
creating, 194, 197
importance of, 191
introduced, 194
type, choosing, 194

Scenario Summary dialog box,� 194,� 197
Scenario Values dialog box,� 191,� 192
screen magnification, changing, xxvii
screen resolution, xxvii
ScreenTips, xxxvii
Script button (equations),� 299
Search box, filtering and,� 123,� 126
search filters,� 123

character strings in, 228
creating, 227, 235
defined, 395
introduced, xvii, 227
in PivotTables, 227, 235

searching, filtering and,� 123
searching Help, xxxix-xl
searching worksheets,� 38,� 40

for formatting, 39
lookup functions, 161
refining searches, 38
unique values and, 160

security
anti-virus software, and macros, 330
encrypting workbooks. See passwords
Excel 2010 levels, changing, 331
hiding formulas, 381
importance of verifying workbook source,  

331, 386
macro, default level, 332
macro, in earlier versions of Excel, 330
macro, in Excel 2010, 330
macro settings, changing, 330
macro warning on Message Bar, 331, 332
macros and, 330
and opening macro-enabled workbooks, 331
passwords. See passwords
read-only copies, creating, 372
saving workbooks for electronic distribution, 372
Windows Defender, 330
workbook authentication (digital signatures), 386

Security Warning Message Bar (macros),� 331,� 332
Select All button,� 12
Select Certificate dialog box,� 386
Select Changes To Accept Or Reject dialog box,� 

376,� 378
Select Data button (charts),� 262,� 265
Select Data Source dialog box (charts),� 262,� 265
selecting cells,� 34
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selecting cells with macros,� 333
selecting ranges,� 34
selecting shapes,� 295
selecting worksheet columns,� 35
selecting worksheet rows,� 35
selections, creating ranges from,� 57
selfcert.�exe Office 2010 digital certificate 

accessory,� 386
Send Backward button (shapes),� 296,� 299
sequences.� See data series
series.� See data series
Set Title dialog box (Web pages),� 389
setting margins,� 310
setting page breaks,� 313,� 317
setting passwords for ranges,� 382
setting passwords for workbooks,� 379
setting passwords for worksheets,� 381,� 384
setting a watch,� 77,� 78
setting workbook properties,� 3,� 5
shading, adding to cells.� See fill color
shadows, SmartArt graphic, changing,� 290
Shape Effects button,� 294
Shape Fill button,� 294
Shape Outline button,� 294
shapes

adding equations to, 296, 299
adding to SmartArt graphics, 289, 292
adding text to, 295, 298
adding to worksheets, 294, 297
aligning, 295, 298
arranging (alignment), 295, 298
arranging (distribution), 295
arranging (order), 296, 299
creating, 294
creating proportionally, 294
distributing, 295
drawing, 294, 297
effects, changing, 294
fill, changing, 294
formatting, 294
as headers, 295
height, changing, 294
height, specifying, 294
as labels, 295
live previews of, 294
macros, assigning to. See shapes (custom buttons)
moving, 295
moving forward and backward, 296
order of, changing, 296, 299
outline, changing, 294
resize handles, 294
resizing, 294
resizing proportionally, 294
rotating, 294
selecting, 295

in SmartArt graphics, moving, 289
text in, aligning, 298
text in, editing, 295
text in, formatting, 295, 300
width, changing, 294
width, specifying, 294

Shapes button,� 294,� 297
shapes (custom buttons)

assigning macros to, 341, 343
running macros from, 341, 344

Shapes gallery,� 294,� 297
Share Workbook button,� 368,� 370
Share Workbook dialog box,� 368,� 370
sharing workbooks

change histories, default setting for, 369
change histories, keeping, 369, 376, 378
change histories, and retention policies, 369
change histories, recommended settings, 369
comments. See comments
defined, 395
digital signatures and. See digital signatures
via e-mail messages, 370, 371
and Excel tables, incompatibility, 369
with Excel Web App, xxiii
hiding formulas, 381, 383
from Highlight Changes dialog box, 375
over intranets, 388
introduced, 367
merging, 371
over networks, 370, 388
options, setting, 368
via Outlook 2010 messages, 370
protecting locked cells, 381, 383
protecting ranges, 381, 384
protecting shared workbooks. See passwords
protecting worksheets, 380, 384
reconciling changes, 369
removing private information with Document 

Inspector, 385
risks of, 385
saving for secure electronic distribution, 372
tracking comment creators, 373
turning off, for reviewing changes, 376
turning on workbook sharing, 368, 370
as Web pages, limitations of, 368
on the Web. See Web pages

Sheet Background dialog box,� 115,� 117
sheet tabs

defined, 395
in workbooks saved as Web pages, 388

Shift key
changing chart size proportionally with, 263
changing shape size proportionally with, 294
creating shapes proportionally with, 294, 297
selecting Slicer data with, 231
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shortcuts.� See keyboard shortcuts
Show All Comments button,� 374
Show Detail button

in subtotal levels, 158
in subtotal outline, 155

Show Detail button (PivotTables),� 226,� 234
Show/Hide Comment button,� 373,� 374
Show Margins button (Backstage view Print 

page),� 310
Show Table of Contents button, xxxix
Sign dialog box (digital signatures),� 386,� 387
Signature Confirmation dialog box,� 387
signatures, digital.� See digital signatures
signing workbooks (digital signatures),� 386
single quotes, in references,� 176
Slicer Tools Options contextual tab,� 232
Slicers,� 228

colored values in, 230
creating, 229, 235
defined, 395
filters and, 230
formatting, changing, 232
hiding, 232
introduced, xvi, 228
light gray or white values in, 230
removing filters with, 232, 236
resizing, 232
selecting values in, 230
Shift and Ctrl keys and, 231, 236

SmartArt, introduced,� 286
SmartArt button,� 286,� 290
SmartArt graphics

adding shapes to, 288, 289, 292
adding text to, 288, 289, 291
adding to worksheets, 288
changing appearance of, 288
changing order of elements, 288, 289, 291
choosing, 287
color, changing, 293
Create Graphic group, 288
creating, 286
Cycle type, 287
displaying all, 287
formatting, 290
Hierarchy type, 287, 290
layout, changing, 292
List type, 287
Matrix type, 287
moving shapes in, 289, 291
from Office.com, 287
Picture type, 287
Process type, 287, 288
Pyramid type, 287
Relationship type, 287

text in, formatting, 290
Text Pane, 289
types, summarized, 287

SmartArt Tools Design contextual tab,� 288,� 289,� 292
SmartArt Tools Format contextual tab,� 288,� 290
software, security,� 330
Solver

Add Constraint dialog box, 202, 204
business planning and, 201
cell references in, 203
compared to Goal Seek, 201
comparison operations in, 203, 205
constraints, 203, 204
constraints, changing, 203
constraints, setting, 202
defined, 395
finding target values with, 201
installing, 201
objectives, setting, 202, 203
preparing to use, 201
results, creating a scenario from, 203
results, saving, 203
results, viewing, 203, 206
setting up problems with, 202, 203
Solver Results dialog box, 203, 206
variables, setting, 202, 204

Solver button,� 201,� 203
Solver Parameters dialog box,� 202,� 203
Solver Results dialog box,� 203,� 206
Sort dialog box,� 146,� 148

custom lists in, 148
My Data Has Headers check box, 146

Sort & Filter button,� 146,� 148
Sort & Filter list

date options, 145
numeric options, 145
Sort Largest to Smallest option, 144
Sort Smallest to Largest option, 145
text options, 145, 148

sort levels
adding, 146, 148
changing order of, 147, 150
changing orientation of, 147
copying, 147
deleting, 147, 151
making case sensitive, 147
maximum number of, 146

sort order,� 146
changing, 147

Sort Options dialog box,� 147
sorting

adding levels, 146, 148
criteria, 146
custom lists, creating, 147, 150
custom sort, creating, 146, 148
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days of the week, 147
default behavior, 147
defined, 144, 395
by fill color, 146, 152
by font color, 146
headers and, 146
by icon, 146
largest to smallest, 144
levels. See sort levels
months, 147
by multiple columns, 146, 148
overview, 143
smallest to largest, 145
Sort & Filter list, 144, 148
special lists, 147
by value, 146

source cells.� See linking
sparklines

best use of, 279
changing appearance of, 279, 280
changing data in, 279
clearing, 279, 280
column type, xv, 277
column type, creating, 278, 279
defined, xv, 259, 276, 395
deleting, 279, 280
destination cell, selecting, 277, 279
formatting, 279
grouping and ungrouping, 279
increasing detail in, 280
line type, xv, 277, 279
purpose of, 276
and regular charts, compared, 279
resizing, 279, 280
selecting ranges for, 277, 279
win/loss type, xv, 277, 278

Sparkline Tools Design contextual tab,� 279,� 280
Special formats (number),� 102
spelling checker,� 43,� 46
Spelling dialog box,� 46
spreadsheet programs

cells in, 251
exporting data to text files, 250

spreadsheets.� See worksheets
square brackets [ ]

in formulas, 63, 73
in references, 176

starting Excel 2010,� 1,� 3
statistics

generating, with Analysis ToolPak, 207, 208
summary, generating with Analysis ToolPak, 209

status bar, AutoCalculate on,� 129
strings.� See text strings
Style dialog box,� 90,� 91 

styles
adding to Cell Styles gallery, 91
applying, 90
Cell Styles gallery, 90
chart. See charts
creating, 90, 91
deleting, 91
Excel table. See table styles
live preview of, 90
overview, 90
PivotTable, 244, 247

subscript, adding to equations,� 299
Subtotal dialog box,� 153,� 157

default options, 157
removing subtotals, 157

SUBTOTAL function
AVERAGE operation, 130
and column headers, 130
compared to AGGREGATE, 131
COUNTA operation, 130
COUNT operation, 130
and filters, 131
function_num argument, defined, 129
ignoring in AGGREGATE function, 132
introduced, 129
limitations of, 131
MAX operation, 130
MIN operation, 130
operations, summarized, 130
operations that exclude manually hidden values, 130
operations that include manually hidden values, 130
PRODUCT operation, 130
STDEV.P operation, 130
STDEV.S operation, 130
SUM operation, 130
syntax, 129
VAR.P operation, 130
VAR.S operation, 130

subtotal level buttons, in outlines,� 156,� 159
subtotal levels,� 154

adding, 156, 158
Hide Detail button, 155, 158
hiding rows in, 155, 158
level buttons, 156, 159
numbered, summarized, 156
removing, 157
Show Detail button, 155, 158
showing rows in, 155, 158

subtotals
adding to worksheets, 154, 158
calculating, 153
columns and, 153
conditional formatting, in PivotTables, 243
defined, 395
outlines. See subtotal levels
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subtotals (continued)
in PivotTables, 237
in PivotTables, and conditional formatting, 243
in PivotTables, hiding, 239
removing all from worksheet, 157

Subtotals button (PivotTables),� 237,� 239
SUM function,� 61,� 69

and filters, 129
and hidden rows, 129
in PivotTables, 237
limitations of, 129

SUMIF function,� 71
SUMIFS function,� 71,� 73,� 74
summaries, scenario.� See scenario summaries
summarizing data.� See also data consolidation; 

formulas; functions; subtotals
with AutoCalculate, 129
in Excel tables, 50, 51
with sparklines. See sparklines

summary formulas, and conditional formatting,� 110
summary functions, PivotTable, changing,� 237
summary statistics, generating with Analysis 

ToolPak,� 209
switching between workbooks,� 1
Switch Windows button,� 10,� 17,� 25
switching themes, effect of,� 95
symbols

adding to equations, 297, 300
Quick Access Toolbar button, changing, 341, 343

synonyms, finding.� See Thesaurus

T
tab bar

introduced, 7
selecting worksheets for printing with, 320, 321

Tab character, as delimiter,� 251,� 254
Tab key, moving through page headers and footers 

with,� 307
table of contents, in Help window, displaying, 

xxxix
table styles

applying, 97
clearing, 97
creating, 96, 97
default, changing, 97

tables, Excel.� See Excel tables
target cells.� See linking
target values

finding with Goal Seek, 198, 199
finding, from multiple input values, 201
finding with Solver, 201
Goal Seek approximation to, 199
identifying in Goal Seek dialog box, 199, 200

tasks, automating.� See macros
templates, chart

applying, 269
applying to existing chart, 269, 273
in Create Charts dialog box, 269
creating, 269, 272
displaying, 269

templates, workbook
adding worksheets to, 168
benefit of, 167
blank, 169
changing, 169
creating, 169, 171
creating workbooks from, 169, 172
defined, 167, 395
Excel 97-2003 file format (.xlt), 169
file format (.xltx), 169, 171
file format, macro-enabled (.xltm), 330
labels in, 168
location, 169
macro-enabled Excel 2010 file format (.xltm), 169
More Templates folder, 170
from Office.com, 169
preconfigured, 170
preparing workbooks for, 168
recently used, 169, 173
removing worksheets from, 168
samples, 169, 172
saving, 169, 174

templates, worksheet
creating, 170, 174
inserting, 170, 174
previews of, 171

text
adding to numbers, 103, 106
adding to shapes, 295, 298
adding to SmartArt graphics, 289, 291
hyperlink, effect of deleting hyperlink on, 361
hyperlink, specifying, 361
Quick Access Toolbar button, changing, 341
in shapes, aligning, 298
in shapes, editing, 295
in shapes, formatting, 295, 300
in SmartArt graphics, formatting, 290
Sort & Filter list options for, 145
sorting, 145, 148
not specifying for hyperlinks, effect of, 361
typing into comments, 373, 374

text box properties, SmartArt graphic,  
changing,� 290

text files
exporting spreadsheet data to, 250
as sources for PivotTables, 250

Text Import wizard,� 252,� 254
text size.� See font size
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text strings, quotation marks in,� 104,� 106
themes

active, and available colors, 95
active, and chart appearance, 261, 267
applying, 94
changing, 96, 100
changing, effect of, 96
changing, effect on charts, 267
and Chart Styles options, 267
colors in palette, 95
creating, 96
default, 94
defined, 94, 395
Office theme, 94
in other Office programs, 96
switching, effect of, 95

Themes button,� 96,� 101
Thesaurus,� 44,� 47
time

adding to page headers and footers, 306
formatting cells for, 93
progression, and trendlines, 259

time of recalculation, using NOW function to 
display,� 61

tools
formatting. See formatting
SmartArt, 288
statistical analysis. See Analysis ToolPak

tools, data entry
AutoComplete, 31
AutoFill, 30
AutoFill Options button, 32, 34
FillSeries, 30
overview, 29
Pick From Drop-Down List, 31, 33

tools, research,� 44.� See also Research task pane
Top 10 AutoFilter dialog box,� 123,� 126
Top 10 filter,� 123
Total row, Excel table,� 50
totals, viewing with AutoCalculate,� 129,� 133
Totals row, hidden, and linking errors,� 177
Trace Precedents button,� 78
tracer arrows,� 75,� 78,� 80

defined, 395
hiding, 76, 79, 80

tracing dependents, to identify errors,� 76
tracing precedents,� 78

to identify errors, 75
Track Changes button,� 375,� 377

accepting or rejecting changes from, 376, 378
saving change history from, 376, 378

tracking changes.� See change tracking
translating words,� 45,� 47
translations, Excel, limitations of,� 45
transposing data, in paste operations,� 37

Trendline button,� 274,� 276
Linear Forecast Trendline option, 275

trendlines
creating, 274, 276
data distribution, choosing, 274, 276
defined, 395
formatting, 275
introduced, 259
length of projection, 275, 276

trends
introduced, 274
value of charts for communicating, 259

troubleshooting formulas,� 60
Trust Center,� 331
Trust Center dialog box,� 331

U
Undo button,� 44

and accepted or rejected changes, not usable, 376
removing filters with, 127

“undo” scenarios, creating,� 194
undoing changes,� 44
Unhide dialog box,� 8,� 10
unhiding columns,� 12
unhiding rows,� 12
unique values

customer IDs, 160
displaying, 132, 133
and headers, 133, 134
and lookup functions, 160
primary key column, 160

updating PivotTables,� 219
updating Web pages,� 389
user input, validating.� See validation rules
user interface, Excel 2010, customizing,� 15
usernames, in comments,� 372,� 373

V
validation circles

displaying, 136, 140
hiding, 137, 140

validation rules
creating, 135
creating entry messages with, 137, 138
creating error messages with, 137, 138
defined, 395
and existing data, 136
introduced, 135
requiring numeric values, 136
setting for multiple cells, 136
specifying minimum and maximum, 138
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validation rules (continued)
specifying whole numbers, 138
turning off, 137
validation circles, 136, 140
violations, displaying, 136, 140

#VALUE! error code,� 75
Value Field Settings dialog box,� 237,� 240
values.� See also numbers

adding together, 60
alternative, defining, 191
alternative, displaying, 191, 193
alternative, in scenarios, 190
average, viewing with AutoCalculate, 129, 133
comparing, with color scales, 109, 110
comparing, with data bars, 108, 111
comparing, with icon sets, 109, 111
count, viewing with AutoCalculate, 129, 133
decimals, displayed as percentages, 198
filtering, in PivotTables, 222, 232
filtering for highest or lowest, 123, 126
ignoring in calculations, 131
linking. See linking
maximum and minimum, 55, 61
monitoring, 77, 78
multiple input, and Solver, 201
and multiple scenario applications, 194
overwriting with Goal Seek, 199
percentages, 198
PivotTable, and use in formulas, 238, 241
in PivotTables, filtering, 222, 232
preserving in “undo” scenarios, 195
projecting. See trendlines
replacing, 38
searching for, 38
searching in, 40
in Slicers, selecting, 230
sorting. See sorting
sorting by, 146
subtotaling, 153
sum of, 60
target. See target values
testing. See conditional formatting
total, viewing with AutoCalculate, 129, 133
unique. See unique values
variable, identifying in Goal Seek dialog box,  

199, 200
Values area (PivotTable).� See PivotTables
variables, Solver, setting,� 202,� 204
VBA (Visual Basic for Applications).� See Visual 

Basic for Applications (VBA) programming 
language

verifying workbook author identity.� See digital 
signatures

viewing macro code,� 332,� 334
viewing macros,� 332,� 334

viewing workbook properties,� 3
View Macros button, adding to Quick Access 

Toolbar,� 339,� 342
View tab, zooming,� 16
views, Page Layout.� See Page Layout view
viruses

avoiding with digital signatures, 386
macros and, 330, 332

visible cells, summarizing,� 129,� 131
Visual Basic Editor

debugger warning dialog box in, 336
editing macros in, 337, 338
getting help with, 337
saving changes in, 339
stepping through macros with, 333
viewing macro code in, 332, 334

Visual Basic for Applications (VBA) programming 
language

macros and, 330, 333
viruses and, 330

VLOOKUP function,� 161
approximate matches, finding, 161, 163
arguments, summarized, 161
cell formats and, 163
display of results from, 161
exact matches, finding, 161, 163
Excel tables and, 161
lookup value, 161
range_lookup argument, limitations of, 161
range_lookup argument settings, 161, 163
ranges and, 161
syntax, 161

volatile functions, defined,� 128

W
watch

defined, 395
deleting, 77, 81
setting, 77, 78

Watch Window
defined, 77
deleting a watch, 77, 81
setting a watch, 77, 78

watermarks, as background images,� 115
Web pages

AutoRepublish and, 389
creating hyperlinks to, 359
Excel Web App, xxiii
formatting workbook labels for, 388
HTML code in, 388
HTML files, 388
hyperlinks to. See hyperlinks
linking to Excel workbooks, overview, 349
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linking to original workbooks, 388
locating for hyperlinks, 359
opening, 388
and PivotTables, loss of interactivity, 389
publishing, 389, 391
publishing entire workbooks as, 389
publishing parts of workbooks as, 389, 391
saving workbooks as, 388, 389. See also HTML files
saving workbooks as, warning message, 390
tags, 388
title bar text, choosing, 389
updating from linked source files, 389, 391
workbooks as, limitations of, 368
workbooks saved as, sheet tabs in, 388

what-if analysis
defined, 395
introduced, 190

What-If Analysis button,� 192
Goal Seek in, 198, 199

width, column, changing,� 11
width, shape, changing,� 294
Windows Defender, and macros,� 330
Windows icons

as embedded file images, 356
as linked file images, 351

Windows Internet Explorer, opening workbooks 
saved as Web pages in,� 388

Windows Mail, and creating mailto hyperlinks,� 361
Windows Phone, accessing Excel data from, xxiii
windows, workbook

arranging multiple, 17, 24
cascading, 17, 25

Win/Loss button (sparklines),� 278
win/loss sparklines

color bars in, 279
creating, 278, 280
defined, 277
positive and negative numbers in, 277, 278

wizards, Text Import,� 252,� 254
Word 2010

linked documents, editing, 352
linking documents to Excel workbooks, 349

word choice, researching,� 44
words

adding to dictionary, 43, 46
sorting, default behavior, 147

workbook, default,� 2
workbook properties

defined, 395
deleting, 4
finding and removing with Document  

Inspector, 385
setting, 3-6
status, setting as Final, 385
viewing, 3

workbooks
adding worksheets to, 171
arranging multiple windows, 17, 24
authenticating. See digital signatures
and broken file links, 350
changes, tracking. See change tracking
comments in. See comments
copying worksheets, 7, 9
creating, 2, 4
creating hyperlinks within, 359, 362
creating from templates, 169, 172
defined, 395
deleted, and linking, 177
displaying side by side, 17
displaying two simultaneously, 17
Document Properties panel, 3
editing, and digital signatures, 387
editing by multiple people. See sharing workbooks
editing in Page Layout view, 304
embedding in other Office documents, 355, 356
embedding other Office documents in, 355
entire, publishing to the Web, 389
Excel display font, changing, 87, 89
filtering ranges, 58
finalized, restoring functionality, 385
finalizing, 385, 387
grouping. See workspaces
hyperlinks in. See hyperlinks
identity of author, verifying. See digital signatures
limiting access to, 379
linked files in, appearance of, 351
linking to other Office documents, 349, 350
linking to the Web, 349
links, introduced, 168
macro-disabled, 330
macro-enabled, 330-331
macro security warning message, 331, 332
macros in. See macros
macros on custom buttons (shapes) in, 341, 343
managing in Backstage view, ix
margins. See margins, worksheet
merging, 371
moving charts to, 264
names, in headers and footers, 305
opening, running macros when, 344
opening simultaneously. See workspaces
Page Layout view. See Page Layout view
previewing in Backstage view, 309, 312, 316
previews, navigating in, 312
printing all worksheets in, 320
properties. See workbook properties
protecting formulas from unauthorized access, 

381, 383
protecting ranges from unauthorized access,  

381, 384
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workbooks (continued)
protecting from unauthorized access, 379, 382, 385
protecting worksheets from unauthorized access, 

380, 384
publishing to the Web, 389, 391
read-only, creating, 372, 385
in references, 176
removing passwords from, 380
removing private information from, 385
renamed, and linking, 177
restoring formatting when opening, 344
saved with Goal Seek results in effect, 199
saved with scenario in effect, 191
saved as Web pages, opening, 388
saving, 3, 6
saving as PDF files, 372
saving as Web pages. See Web pages
saving as XPS files, 372
saving frequency, 3
securing for electronic distribution, 372
Security Warning Message Bar in, 331, 332
sending as e-mail attachments, 370, 371
setting passwords for, 379
shapes, running macros from, 343
shared, and Excel table incompatibility, 369
shared, change history for, 369, 376, 378
sharing. See sharing workbooks
signing (digital signatures), 386
source, importance of verifying, 331, 386
switching between, 1, 17, 24
templates. See templates, workbook
themes. See themes
tracking changes in. See change tracking
viewing macros in, 332
viewing on Internet, 388
viewing on intranets, 388
views, Page Layout. See Page Layout view
as Web pages, moving through, 388

worksheet, target, in data consolidation,� 182
worksheets

adding images to, 113, 116
adding shapes to, 294, 297
adding SmartArt graphics to, 288
adding subtotals to, 154, 158
adding to templates, 168
adding to workbook from Insert dialog box, 171
all in workbook, printing, 320
background images in. See backgrounds
blank, inserting, 170
cells. See cells
changing order of, 8, 9
changing tab color, 8, 9
columns. See columns, worksheet
comments in. See comments
configuration, changing. See PivotTables

copying, 7, 9
creating, 7
creating from imported text files, 250
defined, 395
deleted, and linking, 177, 178
deleting, 8, 10
displaying, 7
dynamic. See PivotTables
elements, selecting for printing, 320
entire, printing, 320
filtering. See filters
fitting on printed pages, 312, 317, 322, 325
formatting. See formatting
headers and footers on, 304
hidden, finding and removing with Document 

Inspector, 385
hidden, redisplaying, 8, 10
hiding, 8, 9
History, adding, 376, 378
macros in. See macros
macros on custom buttons (shapes) in, 341, 343
margins. See margins, worksheet
names, adding to page headers and footers, 306
Page Layout view. See Page Layout view
previewing in Backstage view, 309, 312, 316
previews, navigating in, 312
printing, 318, 321
printing parts of, 322
protecting, 380, 384
purpose of, 7
reducing, to print columns on single page, 312
reducing, to print on single page, 312, 322
in references, 176
removing from templates, 168
renamed, and linking, 177
renaming, 7, 9
resizing, 312, 317, 322, 325
restoring after scenario application, 195
rows. See rows, worksheet
saving as individual HTML files, 388
scaling to fit specified printout pages, 322, 325
scenario summary, creating, 194, 197
searching, 38
selecting for printing, 32–322
setting passwords for, 381, 384
sorting. See sorting
subtotal levels, 154
summary, sparklines in, 277
tabs, changing color of, 8, 9
templates, creating, 170, 174
views, Page Layout. See Page Layout view

workspaces
defined, 167, 395
defining, 184, 185
file format (.xlw), 186
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X
.�xlsm (macro-enabled Excel 2010 workbook) file 

format,� 330
.�xlsx (workbook) file format,� 330
.�xlt (Excel 97-2003 template) file format,� 169
.�xltm (macro-enabled Excel 2010 template) file 

format,� 169,� 330
.�xltx (template) file format,� 169,� 330
.�xlw (workspace) file format,� 186
XML (Extensible Markup Language), defined,� 395
XML Paper Specification (XPS) files, saving 

workbooks as,� 372
XPS files.� See XML Paper Specification (XPS) files

Z
zeros in number formatting,� 103
Zoom button,� 16,� 24
Zoom control,� 16
Zoom dialog box,� 16,� 24
Zoom To Selection button,� 16,� 24
zooming,� 23

overview, 16
specific zoom level, 16
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